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1 Introduction

LumaSpecTM Offline Analyzer was designed by LumaSense Technologies, Inc., to analyze individual
thermal and visual images in conjunction with LumaSense instruments. Images are analyzed using a
variety of tools, and data can be displayed in the form of isotherms, histograms, 3-D profiles, etc.
LumaSpec Offline Analyzer has many other exciting features, like blended thermal/visual overlays
and the ability to assemble composite images in the Mosaic Creator. The desired images and data
displays can be added to LumaSpec Offline Analyzer’s Report Queue in units. In addition,
professional, sophisticated reports are easily assembled from this information in the LumaSpec
Report Writer. The Report Writer is easy to use and compatible with Microsoft Word.

LumaSpec Offline Analyzer software is provided on a disc with a case. The latest version of the
software and PDF documentation are included on the disc. The software supports multiple
languages (English, Japanese, German, French, Spanish, Russian, and Chinese).

1.1 Information About this Manual
This manual provides all of the information you need to configure and use the LumaSpec Offline
Analyzer software with each software package.

This manual assumes you have a working knowledge of the Windows™ Operating System and its
conventions; including how to use a mouse, standard menus and commands, and how to open,
save, and close files. For help with any of these functions, refer to the documentation that came
with your computer.

1.2 Conventions

Section headings appear in large Frutiger type.

Instruction sets appear with Bold headings.

Menu, display, and keyboard options appear in Bold Title Case. (i.e., File, Open, Save, etc.)

Note: The note symbol indicates tips and useful information in this manual. All notes
should be read to effectively operate the instrument.

1.3 System Requirements
LumaSpec Offline Analyzer is designed to operate on a Windows™ based computer with the
following (minimum) components:

2 GHz or faster processor

512 MB Ram or higher

Accelerated Video 24 bit or higher

Windows XP (32 or 64 bit), Vista (32 or 64 bit), Windows 7 (32 or 64 bit), Windows 8
(32 or 64 bit)
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1.4 Getting Started
1.4.1 Installing the Software
To install the LumaSpec Offline Analyzer Software, perform the following procedures:

1. Close all programs on your PC.

2. Insert the LumaSpec Offline Analyzer disc into your CD-ROM Drive.

3. Follow the on-screen instructions to complete the installation.

Note: Your computer may ask you to restart after installing the LumaSpec Offline Analyzer
software. If your computer recommends a restart, follow the on-screen directions.

If you do not get on-screen instructions, it could mean that your auto play feature is disabled. In this
case, open the disc files and click the setup.exe file to launch the application.

The installation places LumaSpec Offline Analyzer inside a LumaSpec Offline Analyzer folder on
your hard drive, default locations:

32 bit: C:\Program Files\LumaSpec Offline Analyzer

64 bit: C:\Program Files (x86)\LumaSpec Offline Analyzer

In addition, the folder houses LumaSpec Offline Analyzer’s Report Writer program. You can access
the programs by going to the Windows Start Menu, to All Program Files, and finally to the
LumaSpec Offline Analyzer folder.

1.4.2 Using LumaSpec Offline Analyzer For the First Time

The first time LumaSpec Offline Analyzer is used after installation, it requires the entry of a valid
serial number. (Your individual serial number is printed on your LumaSpec Offline Analyzer disc
label.) Once a valid serial number is entered, the program will not request it again, unless
uninstalled/reinstalled.

You may use LumaSpec Offline Analyzer for thirty days without a valid serial number. Click the Use
Evaluation button. This evaluation option disappears once a valid serial number has been entered.
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2 Working with the Software Interface

This chapter provides an overview of the user interface, step-by-step instructions for using many of
the features, and how to configure your preferred options and appearance.

To make explanation of LumaSpecTM Offline Analyzer functionality easier, areas of the user interface
have been named. This section will familiarize you with these different interface areas. More
information will be given about these interface areas in later sections.

2.1 Menu Bar
The Menu Bar gives you access to File, Edit, Report Writer, Tools, and Help. These are standard text
menus found at the top left of the LumaSpec Offline Analyzer screen. This section also provides
their corresponding keyboard shortcuts (if applicable).
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2.1.1 File Menu
Sequence Editor

The Sequence Editor allows you to
create, modify, or combine an image
sequence. The Sequence Editor
interface consists of a Frames chart
that displays the frames contained in
the sequence and buttons that allow
you to add, remove, or order the
frames in the sequence, reset the
sequence, and remove all frames.
The Frames chart will be empty until
you add frames using the Add
button.

The function of each arrow button is
described in the chart below:

Move up 25 items Moves a selection up 25 items in the Frames Chart.

Move up 5 items Moves a selection up 5 items in the Frames Chart.

Move up 1 item Moves a selection up 1 item in the Frames Chart.

Move down 1 item Moves a selection down 1 item in the Frames Chart.

Move down 5 items Moves a selection down 5 items in the Frames Chart.

Move down 25 items Moves a selection down 25 items in the Frames Chart.

To move a frame:

1. Select the frame in the chart. You may
select more than one frame by holding
down the Shift or CTRL buttons (selected
frames must be displayed consecutively
in the chart to be moved).

2. Click the appropriate arrow button.

To create a new sequence or to combine/modify
existing sequences:

1. Click the Add button.

2. The thumbnails dialog box will appear.
Select the file or files that you want to
add to the sequence.
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3. Once you are done selecting files, click Load.

If you selected a thermal image, it will be added as one frame to the Frames chart. If you
selected a sequence file, each frame in the sequence will be added as a separate frame in
the Frames chart.

4. If needed, add more thermal images or sequences to the Frames chart by using the Add
button.

Note: All files added to the Sequence Editor must contain images that are the same
size (320x240, 640x480, etc.). If they are not the same size, some files may not be added
to the Sequence Editor.

5. Adjust frames as needed: Move frames up and down in the Frames chart using the arrows.
Remove a frame from the sequence by selecting it in the Frames chart and clicking the
Remove button. You can also remove all frames from the chart by selecting the Reset
button.

6. Once the sequence is complete, click the Save button.

7. A standard Windows™ Save box will appear.
Type the name that you would like the file to
have and click Save. The standard LumaSpec
Offline Analyzer sequence file type (.RTV) will
automatically append to the file.

8. The Sequence Editor Preview window will
appear. It displays a preview of the sequence.
Below the preview is a box that displays the
number of frames in the sequence and the
current frame being viewed, sequence control
buttons, and a close button.

9. If you are not satisfied with the sequence, click
the Close button to return to the Sequence
Editor window and make additional
modifications. To preview the file again, click
Save and overwrite the existing file.

The following are the sequence control buttons available on the Sequence Editor Preview
window:

Stop Stops the playing of the sequence and returns to the first frame to
allow playback from the beginning.

Play/Pause

When the sequence is stopped, the green play button is available to
start the sequence. When the sequence is playing, it becomes a
yellow Pause button, allowing you to pause the sequence and
restart it later from that exact point.

Beginning
Allows you to return to the first frame of the sequence. If you are
already at the first frame, this button is not available and will be
grayed out.

Rewind

Allows you to move backward in the sequence. Press it to move
back one frame. Hold it down to move quickly backward in the
sequence. If you are already at the first frame, this button is not
available and will be grayed out.
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Fast-Forward

Allows you to move forward in the sequence. Press it to move
forward one frame. Hold it down to quickly advance through a
sequence. If you are already at the last frame, this button is not
available and will be grayed out.

End
Allows you to skip to the last frame of the sequence. If you are
already at the last frame, this button is not available and will be
grayed out.

Palette
Options

Allows you to select another color palatte.

Open Opens a new file.

Thumbnails

Unlike the Open or Save buttons, the
Thumbnails button on the Toolbar does not
open a standard Windows™ dialog box.
Instead, it opens the Thumbnails window.
The Thumbnails window allows you to
preview and organize your LumaSpec Offline
Analyzer files. The window is divided into
two main areas: File Options (top) and
Thumbnail Viewer (bottom).

The File Options half of the window helps
you navigate your file system and locate
LumaSpec Offline Analyzer-readable files. It
also allows you to move, copy, and delete
files without closing the window.

The Thumbnail Viewer half of the window
allows you to select and open up to 10 files
at once.

The Thumbnails window makes it easy to
locate, organize, or delete LumaSpec Offline Analyzer files. By default, the Thumbnails window
opens in the LumaSpec Offline Analyzer folder (C:\PROGRAM FILES\ LUMASPEC OFFLINE
ANALYZER\). This is displayed in the Current Path box at the top of the window.

To change the folder or drive where LumaSpec Offline Analyzer looks for files:

1. Click the arrow next to the current drive letter in the Drive section of
the window. Change it to the letter of the drive that your files are
located.

2. In the Source Options area, navigate to the sub folder that contains
your files.

3. If you do not see any files, ensure that the proper file format is
selected in the Image Type portion of the window (to the left of
the Load button).

File Options

Thumbnail Viewer
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You may move, copy, and delete files using the buttons to the right of the Transfer options
section of the window.

To delete files:

1. Select the files that you wish to delete in the Thumbnails Viewer.

2. Click Delete From Source.

3. A box will appear asking you to confirm deletion of the file. If you have selected the correct
file, click Yes.

To move files to a different folder or drive:

1. Select the files that you want to move.

2. In the Target Options section, select the correct drive and folder.

3. Click Transfer: Source -> Target.

4. A dialog box will appear informing you that the files have been moved. Click OK.

To copy files to a different folder or drive:

1. Select the files that you want to move.

2. In the Target Options section, select the correct drive and folder.

3. Click Copy: Source -> Target.

5. A dialog box will appear informing you that the files have been copied. Click OK.
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The Thumbnail Viewer
allows you to view your

files 10 at a time. The Page box on the bottom right of
the Thumbnails window tells you how many "pages"
(groups of 10 files) are in your folder. Click the
dropdown box to select a specific page, or click the
Navigation Buttons to the left of the Page box to move
forward and backward through the pages.

When you locate the files that you wish to open, click on
their thumbnail representations. You may select up to
10. You can even select files from multiple pages as long
as you do not select more than 10. To deselect a file, click
on it again.

Use the Select All or Reset All buttons to
select/deselect all of the files. If Select All results in
more than 10 selected files, only the first 10 will be
opened when you press Load.

At times, you may need to change the color palette to
better see an image in the Thumbnail Viewer.

To change the palette:

1. Click on the arrow of the drop-down menu in
the Color Palette section of the window.

2. Select a new palette.

Note: Changing the color palette in the Thumbnails window only changes the palette of
the Thumbnail Viewer. When the images load, they will load in the default LumaSense
color palette.

Recent (Alt + F, R) Displays the last five recently opened files for easy reference.

Save As (Alt + F, A) - Saves the current file, but gives you an opportunity to re-name.

Save Saves the current file, overwriting the previous version.

Close this file (Alt + F, C) - Closes the current file.

Close all but this file (Alt + F, B) - Closes all but the current file.

Close all files (Alt + F, F) - Closes all files.

Exit Exits the entire program.



LumaSpecTM Offline Analyzer User Manual Working with the Software Interface  17

2.1.2 Edit Menu
Copy Copies an image or data to the clipboard. The default item copied is what is

displayed in the Active Tool Window (lower half of mid-screen).

Copy Special Allows you to copy specific data in several formats.

Thermal image - Copy the Thermal image (.BMP format).

Thermal image with palette - Copy the Thermal image with palette
(in .BMP format).

Thermal image and line profile - Copy the Thermal image with line
profile (in .BMP format).

Thermal image and histogram - Copy the Thermal image with
histogram (in .BMP format).

Thermal image and 3D profile - Copy the Thermal image with 3D
profile (in .BMP format).

Thermal image with visible image - Copy the Thermal image with
visible image (in .BMP format).

Thermal image with visible image and palette - Copy the Thermal
image with visible image and palette (in .BMP format).

Visible image - Copy only the Visible image (in .BMP format).

Thermal image and ROI trend graph - Copy the Thermal image with
ROI trend graph (in .BMP format).

Thermal image and line profile trend - Copy the Thermal image with
line profile trend (in .BMP format).

Export Allows you to export data in several formats.

Excel - Exports data to Microsoft™ Excel. You can choose:

o Thermal image - Creates an Excel document with a tab for ROI
Data and a tab for Image Data, which charts the temperature of
each pixel of the thermal image.

o ROI data - Creates an Excel document with a summary tab and a
tab for each ROI that charts the temperature of each pixel of the
ROI.

o Thermal image and ROI data - Creates an Excel Document with
ROI Summary tab, an Image Data tab, and a tab for each ROI.

o Line profile trend data - When a line is selected in the Line Profile
Trend, this feature creates a line profile trend from your current
frame position forward and generates an Excel document with an
ROI summary tab and a tab with a chart displaying the
temperatures along the line for each slice of the line profile trend.

o ROI trend data - When one or more lines are added to the ROI
Trend chart, this feature creates and ROI trend and exports an
Excel document with an ROI Summary tab and a tab with a chart
displaying the data point per frame along the line.

Text – Exports a .TXT file. You can choose:

o Current frame - Exports the current frame as a tab deliminated
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chart.

o All frames - Exports each frame as a separate file with an
incrementing number automatically appended to the end of the
file name.

BMP – Exports a .BMP file. You can choose:

o Thermal image - Copies the Thermal image.

o Thermal image with palette - Copies the Thermal image with
palette.

o Thermal image and line profile - Copies the Thermal image with
line profile.

o Thermal image and histogram - Copies the Thermal image with
histogram.

o Thermal image and 3D profile - Copies the Thermal image with 3D
profile.

o Thermal image with visible image - Copies the Thermal image
with visible image.

o Thermal image with visible image and palette bar - Copies the
Thermal image with visible image and palette.

o Visible image - Copies only the Visible image.

o Thermal image and line profile trend - Copies the Thermal image
with line profile trend.

o Thermal image and ROI trend graph - Copies the Thermal image
with ROI trend graph.

JPEG – Exports a .JPG format file. You can choose:

o Thermal image - Copies the Thermal image.

o Thermal image with palette - Copies the Thermal image with
palette.

o Thermal image and line profile - Copies the Thermal image with
line profile.

o Thermal image and histogram - Copies the Thermal image with
histogram.

o Thermal image and 3D profile - Copies the Thermal image with 3D
profile.

o Thermal image with visible image - Copies the Thermal image
with visible image.

o Thermal image with visible image and palette bar - Copies the
Thermal image with visible image and palette.

o Visible image - Copies only the Visible image.

o Thermal image and line profile trend - Copies the Thermal image
with line profile trend.

o Thermal image and ROI trend graph - Copies the Thermal image
with ROI trend graph.
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AVI – Exports a sequence to  an .AVI format file.

o Thermal image - Copies the Thermal image.

o Thermal image with palette - Copies the Thermal image with
palette.

o Thermal image and line profile - Copies the Thermal image with
line profile.

o Thermal image and histogram - Copies the Thermal image with
histogram.

o Thermal image and 3D profile - Copies the Thermal image with 3D
profile.

o Thermal image and line profile trend - Copies the Thermal image
with line profile trend.

o Thermal image and ROI trend graph - Copies the Thermal image
with ROI trend graph.

2.1.3 Report Writer Menu
Report Writer Launches LumaSpec Offline Analyzer Report Writer.

Open Report Queue Opens a saved LumaSpec Offline Analyzer Report Queue.

Save Report Queue Saves your current collection in the Report Queue.

Edit Report Queue Brings up the currently open LumaSpec Offline Analyzer Report Queue.

Clear Report Queue Clears the current collection in the Report Queue.

Add file to Report
Queue

Adds the currently opened file to the Report Queue. If you have more than
one file open, only the one whose tab is currently selected will be added to
the queue.

2.1.4 Tools Menu

Mouse Selects the Mouse after using other tools like Text or Zoom.

Text Use this tool to add text labels to an image. Click anywhere on the thermal
image to open the Configure Text, box which allows you to enter the desired
text, configure text alignment, and choose text and background colors or a
transparent background.

To modify an existing text label, select the mouse pointer tool and right-click
the thermal image and select Edit>Text Labels> and then either Configure all
Text Labels or Configure Text Label> and then the the label you want to
configure.

To delete a text label, right-click the thermal image and select Edit>Text
Labels> and then either Delete all Text Labels or Delete Text Label and then
the label you want to delete.

Point This tool collection creates Point Region of Interests (ROIs), which monitor
only one pixel. A Point ROI can measure the Maximum, Minimum, or Point
(simply the temperature at that XY coordinate). The Arrow Point ROI does
not measure temperature and is used only for a visual aide.

Line This tool collection creates Line ROIs. Choose Broken Line, Free, or simply
Line.
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Area This tool collection creates Area ROIs: Annulus, Oval, Polygon, Region,
Rotated Rectangle, and Rectangle shaped ROIs.

Zoom Allows you to zoom in or out of an image. You can choose Manual zoom to
change the mouse pointer to a magnifying glass; left-click an image to zoom
in or right-click to zoom out. You can also choose to zoom to a specific
magnification, either 1/2X, 1X, 2X, 4X, or 8X. If you have a thermal or visual
image open in the Active Tool Window, selecting a magnification will zoom
the image in the Active Tool Window. If you do not have a thermal or visual
image open in the Active Tool Window, the image in the Active Thermal
Window will zoom.

Options This tool opens the Options menus discussed in Section 2.2.

2.1.5 Help Menu
Contents Loads the help files.

About A dialog box with LumaSpec Offline Analyzer program information appears,
including Version and Build Numbers.

LumaSense’s company information is also displayed.

2.2 Tool Bar
The Tool Buttons on the Tool Bar provide convenient access to the most frequently used tools of
the program.

If you do not see a toolbar when LumaSpec Offline Analyzer loads, select Tools > Options from the
Menu Bar to open the Options Window and click on the Appearance Tab. In the upper left
General area, check the box next to Show Toolbar.

Tool Buttons

Open Sequence
Editor

Opens the Sequence Editor window.

Open File Opens an image file.

Thumbnails Opens a menu that allows you to view files as thumbnails and
open up to 10 at once.

Save As Saves the current image to disk, but with the option to re-name it.
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Copy Copy the current image or selection.

Add to Report
Queue

Add the current file to the Report Queue

Report Writer Clicking the arrow next to this icon brings up six choices:

Report Writer - Launches LumaSpec Offline Analyzer
Report Writer.

Open Report Queue - Opens a saved LumaSpec Offline
Analyzer Report Queue.

Save Report Queue - Saves your current collection in the
Report Queue.

Edit Report Queue - Brings up the currently open
LumaSpec Offline Analyzer Report Queue.

Clear Report Queue - Clears the current collection in the
Report Queue.

Add file to Report Queue - Adds the currently opened
file to the Report Queue. If you have more than one file
open, the one whose tab is selected will be added to the
queue.

Mouse Use the mouse to manipulate existing objects.

Text Label Use this tool to add text labels to an image. Click on the thermal
image to open the Configure Text box. You may enter the desired
text, configure text alignment, and choose text and background
colors or a transparent background.

To modify an existing text label, right-click the thermal image and
select Edit >Text Labels > and then either Configure all Text Labels
or Configure Text Label > and then the the label you want to
configure. To delete a text label, right-click the thermal image and
select Edit >Text Labels > and then either Delete all Text Labels or
Delete Text Label and then the label you want to delete.

Point ROIs Clicking the arrow next to this icon brings up four choices:

Maximum - Point ROI that records maximum temperature.

Minimum - Point ROI that records minimum temperature.

Arrow - Point ROI that adds an arrow to the image.

Point - Point ROI that records the temperature at a single
point.

Line ROIs Clicking the arrow next to this icon brings up four choices:

Broken Line - ROI made of an unlimited number of
straight line segments.

Free - Draw a freestyle line ROI.

Line - Single line ROI.

Area ROIs Clicking the arrow next to this icon brings up four choices:
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Annulus - ROI defining a ring-like space between two
concentric circles.

Oval - Oval-shaped ROI, hold down Shift to create a
perfect circle.

Region - Draw a freestyle region ROI.

Polygon - Multi-sided ROI of any shape.

Rotated Rectangle - Rotate a rectange-shaped ROI.

Rectangle - Rectangle-shaped ROI, hold down Shift to
create perfect square.

Zoom Tool Clicking the arrow next to this icon brings up five choices:

Manual - Changes the mouse pointer to a magnifying
glass. Left-clicking on an image will zoom in, while right-
clicking will zoom out.

1/2X Zoom 0.5x - Shrinks the current image to half its
size.

1X Zoom 1x - Returns the current image to its normal size.

2X Zoom 2x - Magnifies the current image twice.

4X Zoom 4x - Magnifies the current image four times.

8X Zoom 8x - Magnifies the current image eight times.

If you have a thermal or visual image open in the Active Tool
Window, selecting a specific magnification (1X, 2X, 4X, or 8X) will
zoom the image in the Active Tool Window. If you do not have a
thermal or visual image open in the Active Tool Window, the
image in the Active Thermal Window will zoom.

Start/Stop
Embedded Audio

Starts/Stops the embedded audio file (originating with cameras
that support this feature).

Options Opens the Options dialog box, allowing you to edit options.

2.3 File Tabs
These tabs sit under the Tool Bar, over the Active Thermal Window, and correspond to opened files.
When a new file is opened, a corresponding File Tab is added for easy navigation amongst multiple
files.

2.4 View Pane
These menus and submenus control which view appears below the thermal image. As each view is
selected, a corresponding Tool Tab opens in the View Tabs section of the LumaSpec Offline
Analyzer interface (near the bottom of the window). In these menus, images are analyzed and
graphs are made. You may choose to have the View Pane constantly open or only open when you
move the mouse to the left side of the screen. Click the tack button in the lower right corner of the
View Pane to toggle between choices.

The View Pane is located down the left side of the LumaSpec Offline Analyzer User Interface. This
set of menus controls the tools shown in the Active Tool Window (lower half of mid-screen). View
Pane menus also show the current file’s properties.
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2.4.1 Show/Hide Function of the View Pane
The View Pane can be made visible or made to appear only when a user moves the mouse to the
left side of the screen. Making the View Pane “show/hide” like this allows for more horizontal
display space for the Active Thermal and Active Tool Windows.

There are two ways to show/hide the View Pane. The first is simply selecting the “Clean” theme in
the LumaSpec Offline Analyzer Options Window. However, this also hides the top Toolbar and
changes the color scheme. To activate the show/hide function of the View Pane with any
appearance theme, check the corresponding box under Appearance in the Options window or use
the View Pane Show/Hide Tack located in the bottom right corner of the View Pane.

The View Pane Show/Hide Tack, shown below, is by default, “tacking down” the View Pane, or
making it a permanent part of LumaSpec Offline Analyzer’s user interface.

If you click on the Tack button, the View Pane is no longer “tacked down,” and goes into
show/hide mode (see the image below.) Then it is only visible when the mouse is moved
over the left side of the screen. You may “tack”or “untack” the View Pane at any time.

2.4.2 View Pane Interface/Controls
You can separately expand/collapse the View Pane Menu Headings (Thermal,
Image Manipulation, Other, and Properties). You can do this by clicking on the
Menu Header Bar.

When expanded, the submenus below each Menu Heading are displayed,
and the arrows on the white round button at the end of the Menu

Header Bar point up.

When a Menu Header is collapsed, the submenus are hidden and the
arrows on the white button point down.

2.4.3 View Pane Menus

Thermal

This section of the manual only briefly describes the Thermal tools. For more information about
these tools, see Chapter 3.

ROI An ROI (Region of Interest) is a specifically defined monitored region of a
thermal image. ROIs may be defined in a variety of shapes, including points,
lines, and two-dimensional areas like ovals and rectangles. You may save a
collection of drawn ROIs as an ROI Template and load the ROI Template for
use in another image. This is especially useful when you are inspecting similar
scenarios repeatedly and want to apply the same ROIs to many thermal
images.

ROI data is displayed in a table in the Active Tool Window (lower half of mid-
screen). The table displays the temperature readings, emissivity, Delta
temperature (C, F, or K), area, and heat quantity for each ROI. You may also
delete, configure, or set the reference of an ROI by right-clicking on it in the
ROI data chart. Points, Lines, and Area ROIs are each shown in their own
table. Toggle between the tables by using the Point, Lines, and Areas tabs at
the top of the ROI tables.
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Thermal Image This View Pane selection has the simple function of showing only the original
thermal image in the Active Tool Window. When the Thermal Image is
clicked in the Thermal View Pane menu, the Active Tool Window displays the
original thermal image, with no ROIs.

Isotherms An Isotherm is a simplified visual representation of the temperature
breakdown on a thermal image.

LumaSpec Offline Analyzer’s Isotherm feature allows you to define up to
eight temperature ranges, replace each range with a single color, and apply
the ranges/colors to the thermal image to create a simplified Isotherm
representation of temperature ranges.

Line Profile The Line Profile feature generates a two-dimensional graph (based on
distance and temperature) using data from an existing line ROI on a thermal
image sequence. To use the Line Profile chart, you must open a sequence file
and define Line ROIs. You may define up to 10 Line Profiles using the pre-
defined colors in the Line Profile chart.

ROI Trend The ROI Trend feature generates a two-dimensional graph using data from
user-defined ROIs on a thermal image sequence. To use the ROI Trend chart,
you must first define ROIs. You may define any sort of ROI you like.

Line Profile Trend The Line Profile Trend feature generates a three-dimensional representation,
based on distance and temperature, of the surface of user-defined Line ROI
on a thermal sequence. To use the Line Profile Trend chart, you must first
define Line ROIs.

Histogram The Histogram feature in LumaSpec Offline Analyzer shows the distribution
of pixel intensity values within a thermal image. The X-axis of the histogram
represents pixel intensity and the Y-axis represents the percent of color count
for each pixel intensity value.

3D Profile The 3D Profile feature of LumaSpec Offline Analyzer generates a three-
dimensional temperature profile of the current thermal image. The three
axes of the graph represent horizontal distance, vertical distance, and
temperature.

Image Manipulation

This section of the manual only briefly describes the Image Manipulation tools. For more
information about these tools, see Chapter 4.

Image Blender The Image Blender feature of LumaSpec Offline Analyzer allows the creation
of a composite blended thermal and visible image. The Temperature Range
Slider Bar allows you to control the area of the overlaid thermal image based
on temperature.

Mosaic Creator The Mosaic Creator feature of LumaSpec Offline Analyzer allows you to
create a larger thermal image by “stitching” together several smaller thermal
images. LumaSpec Offline Analyzer uses mathematical formulas to average
thermal data where individual images overlap. You can rotate and overlap
images to line them up accurately.

To use the Mosaic Creator, first open the images you would like to stitch
together. Then, click the Mosaic Creator under Image Manipulation on the
View Pane.
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Image Subtractor Image Subtractor is a feature of LumaSpec Offline Analyzer that subtracts
one thermal image from another, producing a third, resulting thermal image
with subtracted thermal data. Image Subtractor can be used to produce a
true Delta T thermal image, unaffected by ambient temperature, by
subtracting an image of ambient temperature from an image depicting a
temperature change.

Other

Visible Image

The Visible Image feature of LumaSpec Offline Analyzer provides a
way to quickly view and manipulate a thermal image’s corresponding
visible image in the Active Tool Window. When the Visible Image is
opened in the Active Tool Window, it can be referenced via the View
Tabs on the bottom of the user interface.

To load a visible image:

The Visible Image feature allows you to load or replace a thermal image’s corresponding visible
image file.

1. If the thermal image doesn’t already have visible image, right-click the words No Visible
Image Available or right-click the existing visible image and click Load Visible Image.

2. A standard Windows™ Load dialog box will appear. Select the visible image (a .BMP, .JPEG,
or .TIFF image file) that you would like to associate with the thermal image and click Load.

3. The new visible image will appear in the Active Tool Window. It will also now be displayed
in the Image Blender.

To remove the visible image:

1. Right-click the visible image.

2. Select Remove Visible Image.

3. This will cause the thermal image to either revert
to its default visible image or to display no visible
image at all if it does not have a visible image.

To close the visible image:

1. Right-click the visible image.

2. Select Close Visible Image. However, this only
closes the tool view. It does not remove the visible image.

To copy the visible image to the WindowsTM clipboard:
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1. Right click on the image.

2. Select Copy Visible Image (320 x
240) or Copy Visible Image (640
x 480), depending on the size (in
pixels) that you want the copied
image to be. To include the Thermal
image, select either Copy IR and
Visible Image or Copy IR and
Visible Image with Palette Bar.

File Properties

The File Properties feature of LumaSpec Offline Analyzer allows
you to edit certain file information for each Thermal or
Thermal/Visual combination image file.

To edit the File Properties:

1. Select File Properties under the Other heading on the
View Pane.

2. The File Properties appear in the Active Tool Window:
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The File Properties displayed on the left are fixed fields set when the image is taken with the
camera. The fields on the right are editable in LumaSpec Offline Analyzer. If you add a comment or
memo using the imager in the field, those comments will display in the File Properties (however,
they will still be editable). Editable fields listed below:

Equipment ID Record serial numbers, model numbers or other identifying data about
equipment in this field.

Equipment Location Record information about equipment location here.

Comment Record comments about the thermal or visible image here.

Memo Record a memo about the thermal or visible image here.

User Fields These fields are adaptable to your individual use. To use the User Fields,
first choose a field number (as shown below) and then enter the
corresponding number or wording that you wish to include. Then, in
LumaSpec Offline Analyzer Report Writer, all ten of these User Fields are
available to include as template fields in your custom template.

File Properties correspond to preset properties by the same name in LumaSpec Offline Analyzer’s
Report Writer. The User Field Properties, especially, allow for customization of fields for a variety of
information that is easily accessed in LumaSpec Offline Analyzer’s Report Writer.

2.4.4 Properties
This item on the View Pane is for display only and displays the file properties
recorded by the thermal imager used to take the selected image. As with all the
other View Pane submenus, the Properties submenu is collapsible/expandable.
Leave Properties open for a constant display of File Properties, or
expand/collapse it for quick reference. The File Properties refer to the properties
of the currently selected image file.

Shown right is the properties menu expanded to show details.

2.5 Active Thermal Window
This is the upper half of the main screen. It displays the current thermal image,
drawn ROIs, mosaic image, etc.

2.6 Active Tool Window
This is the lower half of the main screen. It displays the current view of tooling being used,
chart/graph being created, isotherm, visible image, etc.

2.7 View Tabs
As each view is selected in the View Pane, a Tool Tab appears under the Active Tool Window,
allowing for easy navigation between different views.

2.8 Tool Pane
These are the controls for the different views, filtering, emissivity settings, brightness and contrast
(of visible images), heat quantity calculator, and physical distance calculator.
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2.8.1 Temperature Palette
The Temperature Palette is a unique part of
the Tool Pane. While the rest of the Tool
Pane Menu Headers are
expandable/collapsible, the Temperature
Palette is a permanent feature of the
LumaSpec Offline Analyzer user interface.
The Temperature Palette allows you to
customize the thermal image displayed in
the Active Thermal Window by changing the
color scheme and specifying minimum and
maximum temperature values.

To the far right of the Temperature Palette
is a Palette Temperature Scale and, next to
it, the corresponding colors being applied to
the temperatures. To the left of the
Temperature Scale are the Palette Slider Bar
and the Max and Min Temperature boxes. Below the Min Temperature box is the Palette Drop-
Down List, the Invert check box, and the Default Button.

You can change the temperature displayed on the Temperature Scale by right-clicking the Scale and
selecting Celsius, Fahrenheit, or Kelvin. All temperature values in LumaSpec Offline Analyzer will
change to the new unit of measure.

Note: You can also set the default temperature unit in the Options menu, accessible
from the Toolbar or Text Menus. See Section 2.2 for more information about
configuring default options.

To set a Temperature Range Using the Min/Max Boxes:

LumaSpec Offline Analyzer allows you to control the range of temperatures to be used when
viewing or analyzing images and image sequences. Ideally, the span should embrace most of the
temperatures of interest and be equally displaced about some median temperature in the target
area.

1. Click inside the Min Temperature Box located below the Palette Slider Bar.

2. Enter a new minimum temperature value.

3. Press Enter to see the new minimum range applied to the thermal image.

4. Repeat steps 1-3 for the Max Temperature Box (located above the Palette Slider Bar).

To Set a Temperature Range Using the Palette Slider Bar:

The Palette Slider Bar, located between the Max and Min boxes, allows you to fine-tune
the temperature range displayed on the thermal image. The upper Slider Bar handle
controls the maximum temperature visible. The lower Slider Bar handle controls the
minimum temperature visible.

1. Use the gray and red handles to expand or contract the temperature range.

2. Click and drag the between the two handles to move the
slider up or down along the temperature range.

OR,
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Alternately, you can automatically find the level (center temperature) of the entire image
by right-clicking the Temperature Scale and selecting the Autogain feature.

To Return to the Default Temperature Range Values:

LumaSpec Offline Analyzer allows you to easily return to the default Min and Max temperature
range values and Palette Slider position.

1. Click the Default button located at the bottom of the
Temperature Palette.

2. The temperature range and palette slider will return to the
default position as decided by the program.

To Set a New Temperature Color Palette:

It is often useful to change the color palette in order to bring out details in the thermal image that
may be hidden or difficult to see. The Palette drop-down list, found below the Palette Temperature
Scale, allows you to choose from a list of pre-defined color palettes.

1. Click on the arrow next to the current palette name to show the
palette drop-down list.

2. Select the name of the new color palette from the list of options. Once
the new color palette is selected, it is immediately applied to the
thermal image as it appears in the Active Thermal Window.

To Invert the Temperature Color Palette:

LumaSpec Offline Analyzer also has the ability to invert the selected
color palette, which may also help to better define details in the
image. Inverting the palette will cause the colors of the palette to
"flip" upside-down, applying the color for the hottest values to the
coldest temperatures and applying the color for the coldest values to the hottest temperatures.

1. To invert the color palette, check the Invert box below the Color Palette Drop-Down box.

To Copy the Temperature Color Palette:

It may be useful to copy the Temperature Scale and paste it into another
program. To do this, right-click on the Temperature Scale and select Copy IR
Palette Bar. The Temperature Scale and corresponding palette colors will be
copied to the Windows™ clipboard. From there, you can paste the image into
many different programs.

2.8.2 Hot/Cold Spot Detection
The Hot/Cold Spot Detection feature allows you to plot up to 20 of
the hottest and/or coldest spots in an entire image or in a specific
ROI shape.

To Plot Hot or Cold Spots:

1. Click on the arrow next to the Hot Spots drop-down box and
select the number of hot spots that you want to display. You
may choose to plot between 0 and 20 hot spots.

2. Click on the arrow next to the Cold Spots drop-down box and
select the number of cold spots that you want to display. You
may choose to define between 0 and 20 cold spots.

3. To plot hot or cold spots on the whole image, select Entire
Image from the Area drop-down list. To plot hot or cold
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spots for a specific Area ROI, choose the name of the ROI from the drop-down list.

4. Select the size of the pixel region for each hot or cold spot from the Pixel Size drop-down
box.

5. Click Apply.

The defined points will appear on the
image in the Active Thermal Window.
They are automatically labeled MAX
or MIN, depending on whether they
are hot or cold spots. The new hot or
cold spots are numbered consecutively
starting with the hottest or coldest
spot. If any ROIs already exist, the
numbering of the hot or cold spots
will be included in this numbering
system to avoid confusion.

The Active Tool Window displays the
new hot or cold spots as Point ROIs,
with the Temperature, Emissivity, and
Ambient for each displayed in the
Point ROI chart. Each temperature is displayed in the selected temperature type: C, F, or K.  To view
the ROI chart, click on ROI under the Thermal Menu Header on the View Pane. The new hot or cold
spots can be configured and deleted like normal Point ROIs, but they cannot be moved. For more
information about how to configure Point ROIs, see Section 3.1.4 Configuring ROIs.

2.8.3 Filtering
The filtering feature allows you to apply different effects to your image to make the image easier
to see or to highlight certain aspects of the image. Below is a list of filters and what they can be
used for.

Averaging

An image with 3x3 averaging applied twice. An image with 5x5 averaging applied twice.

The Averaging filter eliminates noise by computing the mean (average) of an area and applying
that value to the pixels within that area, smoothing the image. You may choose to compute the
average of the image by either 3x3 or 5x5 pixel area. Selecting 3x3 from the Advanced Filter
Options drop-down menu provides a smaller, more refined calculation, while selecting 5x5 produces
a broader, more noticeable effect. You may apply one or both of the effects multiple times to reach
the desired averaging level.



LumaSpecTM Offline Analyzer User Manual Working with the Software Interface  31

Focus

An image with default focus. An image with details enhanced twice.

The Focus filter allows you to enhance the details of an image. Select the + from the Advanced
Filter Options drop-down menu to enhance different details. You may enhance different details as
many times as you like by clicking Apply more than once. To decrease visible details on the picture
without completely resetting, use the - setting on the Advanced Filtering Options drop-down menu.
However, you may only decrease visible details only until image will reach default settings. The
focus filter cannot be used to blur the image.

Gaussian

An image with 3x3 gaussian smoothing applied 2x. An image with 5x5 gaussian smoothing applied 2x.

The Gaussian smoothing filter is used to blur images to remove detail and noise. You may choose
to apply gaussian smoothing in either 3x3 or 5x5 pixel areas. Selecting 3x3 from the Advanced Filter
Options dropdown menu provides a smaller, more refined effect, while selecting 5x5 produces a
broader, more noticeable effect. You may apply one or both of the effects multiple times to reach
the desired smoothing level.
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Laplacian

An image with 3x3 laplacian filtering applied 1x. An image with 5x5 laplacian filtering applied 1x.

The Laplacian filter highlights the edges in an image by enhancing regions of rapid-intensity
change. You may choose to apply laplacian filtering in either 3x3 or 5x5 pixel areas. Selecting 3x3
the Advanced Filter Options drop-down menu provides a smaller, more refined effect, while
selecting 5x5 produces a broader, more noticeable effect. You may apply one or both of the effects
multiple times to reach the desired highlight level.

Median

An image with 3x3 median smoothing applied twice. An image with 5x5 median smoothing applied twice.

Median filtering reduces speckle noise and salt and pepper noise. Its edge-preserving nature makes
it useful in cases where edge blurring is undesirable. You may choose to apply median smoothing in
either 3x3 or 5x5 pixel areas. Selecting 3x3 from the Advanced Filter Options drop-down menu
provides a smaller, more refined effect, while selecting 5x5 produces a broader, more noticeable
effect. You may apply one or both of the effects multiple times to reach the desired smoothing
level.

Prewitt

An image with its horizontal edges highlighted/ An image with its vertical edges highlighted.

The Prewitt filter highlights edges by finding the edge orientation for each pixel in the image. You
may choose to highlight either vertical or horizontal edges. To highlight all horizontal edges in the
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image, select Horizontal from the Advanced Filtering Options; to highlight all vertical edges in the
image, select Vertical. You may apply either effect multiple times to reach the desired highlight
level. However, you may not highlight both vertical and horizontal edges at the same time. Thus,
highlighting horizontal edges will undo any highlighting of the vertical edges, and vice versa.

Sharpen

An image with default sharpness.   A sharpened image.

The Sharpen filter enhances the details and edges in a picture. Select the + from the Advanced
Filter Options drop-down menu to sharpen the picture. You may sharpen the image as much as you
like by clicking Apply more than once. If you would like to unsharpen the picture without
completely resetting, use the - setting on the Advanced Filtering Options drop-down menu.
However, you may only unsharpen the image until it reaches reaches the image default. The
Sharpen filter cannot be used to blur the image.

Sobel

An image with its horizontal edges highlighted.  An image with its vertical edges highlighted.

The Sobel filter highlights edges by comparing gradients within the image to determine which
parts of the image represent an edge and how that edge is likely to be oriented. You may choose to
highlight either vertical or horizontal edges. To highlight all horizontal edges in the image, select
Horizontal from the Advanced Filtering Options. To highlight all vertical edges in the image, select
Vertical from the Advanced Filtering Options. You may apply either effect multiple times to reach
the desired highlight level. However, you may not highlight both vertical and horizontal edges at
the same time.

Thus, highlighting horizontal edges will undo any highlighting of the vertical edges, and vice versa.

To apply a filter:

1. Click on the Filtering menu header in the Tool Pane.

2. Select the desired filter from the Filtering drop-down box.
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3. Select the desired pixel size from the Advanced Filter Options drop-down box. Depending
on the filter you have selected, you will be able to select pixel size (3x3 or 5x5), Increase or
Decrease (- or +), or alignment (Horizontal or Vertical).

2.8.4 Emissivity

Emissivity is the ratio of the infrared energy radiated from the surface of a target to the infrared
energy radiated from a blackbody at the same temperature. The emissivity varies with the surface
condition of the object and also with temperature variation and wavelength.

Depending upon the camera selected, LumaSpec Offline Analyzer provides the ability to control the
camera’s Scene Emissivity. Emissivity for the correction can be selected within the range of 0.01 to
1.00.

LumaSpec Offline Analyzer also allows you to take into account the ambient temperature of the
area in which the camera is installed and the attenuation factor of a reading as it is transmitted
through the lens. These values are configured in the Ambient and Transmission areas of the
Emissivity menu and are included in the instructions below.

In addition, if an image is opened and it contains a coefficients table (available with most handheld
camera files), the Emissivity tool will display a Correction Type dropdown list with three available
selections:

None Uses Emissivity Value and Ambient Value for correction.

Transmission Uses Emissivity Value, Ambient Value, and Transmission Value for
correction.

Distance Uses Emissivity Value, Ambient Value, Distance Value, and Relative
Humidity Value for correction.

Note: This section deals with setting scene emissivity. To learn how to configure emissivity
for specific ROIs, see Section 3.1.5.

To control the emissivity for an image with no coefficients table:

1. On the Tool Pane, click on the Emissivity menu header.

2. Enter the appropriate emissivity value in the Emissivity text box.

If you need to find the emissivity of a certain material, click the Emissivity table button to
see a table with common materials and their emissivity values. Select the appropriate
material and the emissivity value appears at the top of the dialog box. Click Select and the
emissivity will automatically be entered into the Emissivity box.
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3. Enter the appropriate ambient value in the Ambient text box.

4. Enter the appropriate transmission value in the Transmission text
box.

5. Click Apply.

To revert to camera presets and undo your changes, press the Reset
button.

To control the emissivity for an image with a coefficients table:

1. On the Tool Pane, click on the Emissivity menu header.

2. Enter the appropriate emissivity value in the Emissivity text box.

If you need to find the emissivity of a certain material, click the Emissivity table button to
see a table with common materials and their emissivity values. Select the appropriate
material and the emissivity value appears at the top of the dialog box. Click Select and the
emissivity will automatically be entered into the Emissivity box.
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3. Enter the appropriate ambient value in the Ambient text box.

4. If desired, select the Correction Type using the dropdown box and enter the appropriate
values into the additional fields.

5. Click Apply.

To revert to camera presets and undo your changes, press the Reset button.

To see the changes to scene emissivity, scene transmission, and the temperature values, click on
Properties in the View Pane (pictured below, left), or select File Properties from the Other
menu on the View Pane (pictured below,right).

2.8.5 Brightness/Contrast

You can modify the brightness and contrast of a visible image using the Brightness and Contrast
feature of the Tool Pane. Increasing or decreasing the brightness of an image increases or decreases
its overall brightness. Increasing or decreasing the contrast of an image will increase or decrease the
dynamic range of the image and affect its highlights and shadows.

To change the brightness or contrast of an image:

1. Choose or open a file with a visible image in it.

2. Select either Image Blender or Visible Image from the View Pane so that you can see
the visible image.
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3. Click on the Brightness and Contrast menu header on the Tool Pane.

4. Click on the Increase or Decrease Brightness and/or Contrast buttons until the desired
effect has been achieved.

You may also select whether the effect applied to the image is coarse or fine by selecting the Coarse
or Fine options at the bottom left of the Brightness and Contrast box. The Coarse option will apply
brightness or contrast more heavily than the Fine option.

Brightness increased five times with the Fine setting enabled. Brightness increased five times with the Coarse setting enabled.

To undo modifications to the brightness and contrast of the picture, press the Reset button at the
bottom right of the picture to restore the visible image to its original appearance.

2.8.6 Heat Quantity
The Heat Quantity feature calculates the heat in a thermal image using
ambient and external temperatures and the calibrated area supplied by
the Physical Distance feature (see the next section).

To calculate heat quantity, you must first calibrate the Physical Distance
menu of the Tool Pane. This gives LumaSpec Offline Analyzer the
needed dimensions to properly determine heat quantity. However, the
dewpoint can still be calculated without specifying physical distance.

To calculate heat quantity:

1. Open or select the thermal image for which you wish to calculate
heat quantity.

2. Click the Heat Quantity menu of the Tool Pane to expand it.

3. Enter the Ambient Temperature value.

4. Enter the Exterior Temperature value.

5. Select the unit of measurement you'd like the heat quantity
displayed in from the Measurement Unit drop-down box. The
heat in a thermal image can be calculated in Watts, BTU/Hr, or R
Value.

6. If applicable, enter the percentage of humidity in the environment in the Relative
Humidity box. You must do this to see a Dewpoint value calculated.
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7. To generate an isotherm value for all temperatures below dew point temperature, check
the Link with Isotherm box. If no value is given for Relative Humidity, an Isotherm won’t
be created.

8. Click Apply.

Note: Temperature values are calculated in degrees Celsius, Fahrenheit, or Kelvin,
depending on the temperate units you have selected. To change your temperature units,
right click the Temperature Scale of the Temperature Palette.

Heat quantity measurements are calculated for all Area ROIs. If you
entered a humidity value, the calculated dewpoint for the thermal image
will be displayed next to the Dewpoint text label.

If you checked the Link with Isotherm box, the Isotherm will be applied to the Thermal image:

You can view the isotherm values by selecting Isotherms from the Thermal menu of the View
Pane.

You can view each heat quantity measurement by selecting ROI from the Thermal menu of the
View Pane. Heat quantity values appear in a column that is labeled with the unit of measure that
you selected from the Measurement Unit drop-down box.

You can remove heat quantity data by clicking Reset in the Heat Quantity menu of the Tool
Pane.
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2.8.7 Physical Distance
The Physical Distance feature calculates dimensions of calibrated area based on the camera lens you
are using and the distance from the camera to the target object.

To calculate dimensions:

1. Select or open the thermal image for which you wish to
calculate dimensions.

2. Click on the Physical Distance menu header on the Tool
Pane to expand it.

3. Ensure that the correct camera lens type is selected from
the Camera Lens drop-down box.

4. Enter the distance from the camera to the target object in
the text box of the Distance to Target area and select the
correct unit of measure from the drop-down menu. You
may express distance in inches, feet, millimeters, meters,
or kilometers.

5. Click Apply.

The dimensions of the thermal image are now calculated in the
unit of measure that you chose in the Distance to Target drop-down menu. The dimensions of the
thermal image can be viewed by clicking on the File Properties submenu of the Other menu on
the View Pane.

You can also view the length of Line ROIs and the area of Area ROIs by clicking on ROI in the
Thermal menu of the View Pane.

The lengths of the Line ROIs are displayed in the Length column of the Lines tab:

The area of Area ROIs is displayed on the Areas tab in the column labeled Area followed by your
chosen unit of measure squared.

To remove these measurements, click Reset on the Physical Distance menu of the Tool Pane. All
dimensions will revert to being measured in pixels.

Note: Clicking Reset on the Physical Distance menu of the Tool Pane also causes all Heat
Quantity measurements to be removed from the Area ROI chart. However, all Heat
Quantity values will remain configured in the Heat Quantity menu of the Tool Pane and
will reappear if Physical Distance is applied later.
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2.9 Status Report
Found in the lower left corner of the LumaSpec Offline Analyzer interface, this area displays current
or recently completed actions.

2.10 Sequence Control Panel
Found in the lower middle of the LumaSpec Offline Analyzer interface, this is a standard set of
controls for playing, stopping, and fast-forwarding or rewinding through frames of a recorded
sequence.

When a sequence file is loaded, the number of frames in the sequence and the current frame being
displayed are shown in the Frame Position box. Also, the Play, Fast-Forward, and Beginning buttons
become un-grayed and may now be used to view the sequence.

When a sequence is playing, the Stop and Pause buttons are available. When the sequence is
paused and not at the end or beginning of the sequence, the Beginning, Rewind, End, Fast-Forward
are available for moving forward or backward in the sequence, and the Stop and Play buttons are
available to either stop playing the sequence and return to the beginning or to resume playback of
the sequence from where it left off.

When a sequence has reached its last frame, it stops at that frame unless you have checked the
Continuous Playback box in the Select Frame Delay box (See below for more information about the
Select Frame Delay dialog box), in which case the sequence will loop and begin playing again from
the beginning. When the sequence is stopped at the last frame, the Play, Rewind, and Beginning
buttons are available.

To move to a specific frame in the
sequence, you can double-click the Frame
Position box. A Go to frame dialog box
will appear telling you the frame that you
are currently on and allowing to enter the
number of the frame you'd like to move
to.

You may also move forward or backward
through a sequence using the Frame Slider
Bar. To do this, click on the slider bar to the left of the Frame Position box and drag it forward or
backward. Watch the Frame Position box to determine the exact frame you are viewing.

You may also right-click on the Sequence Control Panel (or anywhere on the lower bar of the
LumaSpec Offline Analyzer interface) to get a Select Frame Delay box. Here you can set the frame
rate and enable/disable Continuous Playback. It is useful to modify the frame rate if you want your
sequence to play faster or slower.

To alter the frame rate:

1. Right click the bar at the bottom of the LumaSpec Offline Analyzer interface. The Select
Frame Delay dialog box appears.
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2. Enter a new frame rate in the Time box and select either milliseconds or seconds from the
Unit drop-down box.

3. To repeat the sequence, check the Continuous Playback box. This causes the sequence to
loop, beginning at the end again as soon as it finishes. (To stop playback, click the Stop or
Pause buttons on the Sequence Control bar.)

4. Click OK.

2.11 XY Coordinates, Color Box, and Temperature Point
In the lower right corner of the LumaSpec Offline Analyzer interface is the area that displays the XY
coordinates of your mouse (current pixel), the temperature of the pixel, and the color
representation of that temperature.

2.12 Setting Options
The software allows you to establish various customized user preferences and control settings.
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2.12.1 Accessing the Options window
To access the Options window:

Select Tools from the Menu Bar at the top of the display and then select Options

OR,

Select the Options button
from the Tool Bar also
located at the top of the
display.

The Options window will appear.

2.12.2 Setting General Options

The General tab of the Options window is
used to establish general software settings
relating to Language, Decimal Format,
Temperature Unit, Pop-Up Tools, and File
Location Paths used for Default Sequences and
ROI Collections.

Setting Default Paths

Setting default paths allow you to save time by
automatically navigating to a set path.

To set the source image path::

1. Select the General tab from the
Options window.

2. Click on the  button next to Source
image path to bring up a standard
Windows™ dialog box where you will be
able to browse for an existing folder or
to create a new folder in a directory of your choice.

3. Choose a location.

4. Click OK to save the location and to close the Windows™ dialog box.

5. Select another option to be configured

OR,

Click OK to close out of the Options window.

To set the default destination image path:

1. Select the General tab from the Options window.

2. Click on the  button next to Destination image path to bring up a standard
Windows™ dialog box where you will be able to browse for an existing folder or to create
a new folder in a directory of your choice.

3. Choose a location.

4. Click OK to save the location and to close the Windows™ dialog box.

5. Select another option to be configured

OR,
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Click OK to close out of the Options window.

To set the default visible image path:

1. Select the General tab from the Options window.

2. Click on the  button next to Visible image path to bring up a standard Windows™
dialog box where you will be able to browse for an existing folder or to create a new
folder in a directory of your choice.

3. Choose a location.

4. Click OK to save the location and to close the Windows™ dialog box.

5. Select another option to be configured

OR,

Click OK to close out of the Options window.

Setting Report Options

These options allow you to choose the size (or quality) of the images included in reports. This
section also allows you to select the option to compress visible images.

To set the thermal image size:

1. Select the General tab from the Options window.

2. Click on the arrow next to Thermal image size to expose the drop-down list.

3. Select the desired size.

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

To set the graph size:

1. Select the General tab from the Options window.

2. Click on the arrow next to Graph size to expose the drop-down list.

3. Select the desired size.

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

To set the visible image size:

1. Select the General tab from the Options window.

2. Click on the arrow next to Visible image size to expose the drop-down list.

3. Select the desired size.

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.
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5. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

To compress visible images:

1. Select the General tab from the Options window.

2. Click the checkbox next to Compress visible image?.

3. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

4. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

Setting Default Load Image Options

To set the image type:

1. Select the General tab from the Options window.

2. Click on the arrow next to Image type to expose the drop-down list.

3. Select the desired image type.

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

To set the image temperature scale:

1. Select the General tab from the Options window.

2. Click on the arrow next to Image temp. scale to expose the drop-down list.

3. Select the desired image temp. scale.

4. If you select User defined, type the appropriate values in the scale boxes.

5. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

6. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

Setting ROI Preferences

To set the ROI preferences:

1. Select the General tab from the Options window.

2. Select the desired ROI preference.

3. If selection is User Defined, select  to navigate to the ROI template.
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4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

Setting General Options

To set the language preference:

Note: Languages currently supported include English, Japanese, French, German, Spanish,
Russian, and Chinese. Note that this list is subject to change at any time by the
manufacturer.

1. Select the General tab from the Options window.

2. Click on the arrow next to the Language choice to expose the Language drop-down
list.

3. Select the desired Language.

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.

To set the default color palette:

1. Select the General tab from the Options window.

2. Click on the arrow next to the Default Color Palette to expose the drop-down list.

3. Select the desired color palette.

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your option(s) and close out of the Options window.

To set the temperature unit:

1. Select the General tab from the Options window.

2. Click on the radio button next to the Temperature Unit (Celsius, Fahrenheit, or Kelvin)
you wish to set as the default.

3. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

4. Select another option to be configured

OR,

Click OK to set your option and close out of the Options window.
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Setting the Default Camera Lens

To set the default camera lens:

1. Select the General tab from the Options window.

2. Click on the arrow under Default Camera lens to expose the drop-down list.

3. Select the desired camera lens.

4. Click Apply.

5. Select another option to be configured

OR,

Click OK to set your option(s) and close out of the Options window.

2.12.3 Setting Appearance Options

The Appearance tab of the Options window is used
to establish settings for Appearance of text and colors
relating to the workspace, view pane, tool pane,
graphs, and ROIs.

Setting Appearance

To change colors:

1. Select the Appearance tab from the Options
window.

2. Click the color box to bring up the color
dialog box. Note that you can select Palette,
Web, or System colors. For more color options,
right click the Palette tab to get a WindowsTM

color box that allows you to define colors by
their hue, saturation, and lightness or red,
green, and blue (RGB) values.

To select a specific color from any element visible on the screen, select
the eyedropper at the bottom of the Palette tab and move it over the
desired color with the mouse. The color will be previewed in the color
menu. Left-click to capture the color to the bottom of the Palette tab.

3. Select a new color.

4. Click OK to apply the theme you have selected and
to close the dialog box.

OR

5. Click Apply if you would like to set the change and
see the effect on the display before closing the
Options window.

6. Select another option to be configured

OR,

Click OK to set your color and close out of the
Options window.
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Note: As you are selecting colors, you may hit Apply at any time to view your choices
within LumaSpec Offline Analyzer. You can easily copy settings from the View Pane to
the Tool Pane with the “Copy to tool pane settings” button, or vice versa. You can
reset any custom color settings to their default settings using the “Reset to default
settings” button in each respective section.

To set a theme:

1. Select the Appearance tab from the Options window.

2. Click the drop-down arrow under Themes to choose a pre-defined color scheme.

3. Click OK to apply the theme you have selected and to close the dialog box.

OR

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your theme and close out of the Options window.

To use explorer style:

1. Select the Appearance tab from the Options window.

2. Mark the checkbox next to Use explorer style (either View Pane or Tool Pane).

3. Click OK to apply the theme you have selected and to close the dialog box.

OR

4. Click Apply if you would like to set the change and see the effect on the display before
closing the Options window.

5. Select another option to be configured

OR,

Click OK to set your theme and close out of the Options window.

To turn off the Tool Bar:

1. Select the Appearance tab from the Options window.

2. Unmark the checkbox next to Show tools tabs.

3. Select another option to be configured

OR,

Click OK to set this option and close out of the Options window.

To autohide the View Pane:

Autohide allows you to hide the View Pane until you move your mouse over the left side of the
program window.

1. Select the Appearance tab from the Options window.

2. Mark the checkbox next to Autohide.

3. Select another option to be configured

OR,
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Click OK to set this option and close out of the Options window.

2.12.4 Setting Company Information

In the Company Information tab, fill in your own
company information. This will become the default
information for your LumaSpec Offline Anaylzer
Reports.
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3 Working With Thermal Tools

3.1 Working with Regions of Interest (ROI)
Regions of Interest (ROIs) are used to
indicate points or other areas of interest on
the thermal image for monitoring
temperature readings and other details. ROIs
may be defined in a variety of shapes,
including points, lines, and two-dimensional
areas like ovals and rectangles.

You may save a collection of drawn ROIs as
an ROI Template and load the ROI Template
for use in another image. This is especially
useful when you are inspecting similar
scenarios repeatedly and wants to apply the
same ROIs to many thermal images.

ROI data is displayed in a table in the Active Tool Window (lower half of mid-screen). The table
displays the temperature readings, emissivity, Delta temperature (C, F, or K), area, and heat quantity
for each ROI. You may also delete, configure, or set the reference of an ROI by right-clicking on it in
the ROI data chart. Points, Lines, and Area ROIs are each shown in their own table. Toggle between
the tables by using the Point, Lines, and Areas tabs at the top of the ROI tables.

3.1.1 Creating an ROI Object

Point ROIs

A Point ROI is used to mark a single pixel on the image so that its temperature can be
displayed and monitored through the ROI, Trend, Histogram, and Alarm Active Tool Window

and pop-up windows.

LumaSpecTM Offline Analyzer software also allows you to set the Point temperature value as the ROI
Reference for comparison against the temperature reading of other ROIs in the image. The
temperature differences for each ROI based on this reference will be shown in the Delta C, Delta F,
or Delta K Column of the applicable ROI Charts.

See Section 3.1.3 for more information on Working with the ROI Charts.

There are four Point ROI types available:

Maximum A point monitoring the maximum temperature within a thermal image.
Moves with maximum temp. point during sequence playback.

Minimum Point measuring the minimum temperature within a thermal image. Moves
with minimum temp. point during sequence playback.

Point A point you plot on the thermal image and temperature is monitored at a
single set of pixel coordinates.

Arrow Not a true ROI, but an indicator that is used to highlight areas or ROIs.
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Note: Use the Arrow selection provided under the Point ROI menu to draw attention
to a section of the thermal image or an ROI. The Arrow is not a true ROI since it does
not measure temperature data or appear in the ROI Data Table in the Active Tool
Window.

To create a point ROI:

1. Select Point from the Tools Menu or from the Tools Button located at the top of the
display.

2. Left click on the thermal image at the place where you would like to place your Point ROI.

Note: Maximum and Minimum Point ROIs are automatically assigned to the minimum
and maximum temperature points within a thermal image. Once you select these ROI
options (from the Text Menus or Toolbar), the point is automatically plotted. If you
have already assigned a Minimum or Maximum Point and choose these ROI tools again,
the Minimum or Maximum ROI tool will default to a normal Point ROI, and you must
plot it on the thermal image.

Line ROIs

The Line ROI object shape allows you to mark a region of interest with a straight line, broken
line, or free line. With a Line ROI, you will be able to monitor changes to the minimum,

maximum, and average temperature values of all the pixels along the line.

Temperature values and other details of this Line ROI can be monitored through the ROI, Line,
Trend, Histogram, and Alarm Active Tool Window and pop-up windows.

LumaSpec Offline Analyzer also allows you to set the Line Minimum, Maximum, or Average
temperature value as the ROI Reference for comparison against the temperature reading of other
ROIs in the image. The temperature differences for each ROI based on this reference will be shown
in the Delta C, Delta F, or Delta K Column of the applicable ROI Charts.

There are three Line ROI types available:

Broken The Broken Line ROI object allows you to mark a region of interest with a
number of connected line segments. With a Broken Line ROI, you will be
able to monitor any changes to the minimum, maximum, and average
temperature values of all pixels along the line segments.

Free The Free Line ROI object shape allows you to mark a region of interest with
a freehand line. With a Free Line ROI, you will be able to monitor changes to
the minimum, maximum, and average temperature values of all the pixels
along the non-linear line.

Line The Line ROI object shape allows you to mark a region of interest with a
straight line.

See Section 3.1.3 for more information on Working with the ROI Charts.

To create a line ROI:

1. Select the Line ROI object from the Tools Menu or from the Tools Button located at the
top of the display.

2. Select the type of line you would like to use.

3. Left click on the thermal image at the place where you would like to start your Line ROI.
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4. Drag the mouse to form the Line ROI. (For a Free Line ROI, drag your mouse along the
path you would like your ROI to appear.)

5. Click the left mouse button where you would like the Line ROI to end. (Repeat as necessary
to add additional lines for a Broken Line ROI).

To change the shape of a line ROI:

1. Move the mouse over an endpoint of the Line ROI until the resize handle icon  appears.

2. Hold the left mouse button down and drag the end point to change the length or angle of
the Line ROI.

3. Release the mouse button to complete the change.

Adjustments to a Line ROI

Area ROIs

The Area ROI object allows you to mark a region of interest with various shapes. With an Area ROI,
you will be able to monitor any changes to the minimum, maximum, and average temperature
values of all pixels within the area of the shape.

Temperature values and other details of this Area ROI can be monitored through the ROI, Trend,
Histogram, and Alarm Active Tool Window and pop-up windows.

LumaSpec Offline Analyzer also allows you to set the Area Minimum, Maximum, or Average
temperature value as the ROI Reference for comparison against the temperature reading of other
ROIs in the image. The temperature differences for each ROI based on this reference will be shown
in the Delta C, Delta F, or Delta K Column of the applicable ROI Charts.

See section 3.4 for more information on Working with the ROI Charts.

There are six area types available:

Annulus Allows you to mark a region of interest with ring-like shape. With an Annulus
ROI, you will be able to monitor any changes to the minimum, maximum, and

average temperature values of all pixels within the area between the inner radius
and the outer radius of the annulus.

Oval Allows you to mark a region of interest with an elliptical shape. With an Oval
ROI, you will be able to monitor any changes to the minimum, maximum, and

average temperature values of all pixels within the area of the circle.

Region Allows you to mark a region of interest with a freehand region shape. With
the Region ROI, you will be able to monitor any changes to the minimum,

maximum, and average temperature values of all pixels within the region.

Rectangle Allows you to mark a region of interest with a rectangle shape. With a
Rectangle ROI, you will be able to monitor any changes to the minimum,

maximum, and average temperature values of all pixels within the area of the
rectangle.
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Rotated
Rectangle

Allows you to mark a region of interest with a rectangle shape, which can then
be rotated. With a Rotated Rectangle ROI, you will be able to monitor any

changes to the minimum, maximum, and average temperature values of all pixels
within the area of the rectangle.

Polygon Allows you to mark a region of interest with a multi-sided shape. With a
Polygon ROI, you will be able to monitor any changes to the minimum,

maximum, and average temperature values of all pixels within the area of the
polygon.

To create an area ROI:

1. Select the Area ROI object from the Tools Menu or from the Tools Button located at the
top of the display.

2. Left click on the thermal image at the place where you would like to start your Area ROI. If
you want a perfect rectangle or circle (oval), hold the Shift key down as you perform the
following step.

3. Hold the left mouse button down and drag the mouse to form the Area ROI.

4. Release the mouse button when you are finished drawing your Area ROI.

Note: You can obtain a perfect rectangle or circle (oval) by holding down the Shift key as
you draw the shape.

To change the shape of an area ROI:

1. Move the mouse over an edge of the Area ROI object until the resize handle icon
appears.

2. Hold the left mouse button down and drag the edge of the Area ROI to make your
adjustment.

3. Release the mouse button to complete the change.

4. Repeat steps 1 through 3 until all desired adjustments are made.

Adjustments to Rectangle ROI

To change the orientation of a rotated rectangle ROI:

1. Move the mouse over an outer edge along a side of the Rotated Rectangle ROI until the
resize handle icon appears.

2. Hold the left mouse button down and drag the mouse to rotate the rectangle.

3. Release the mouse button to complete the change.
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Adjustments the Orientation of a Rotated Rectangle ROI

To create a polygon ROI:

1. Click the Area ROI object from the Tools Menu or from the Tools Button located at the
top of the display.

2. Select the Polygon ROI from the Area ROI submenu.

3. Left click on the thermal image at the place where you would like to start your Polygon
ROI.

4. Drag the mouse to form a Polygon ROI line segment.

5. Click the left mouse button where you would like the line segment to end.

6. Repeat steps 3 through 4 to add additional line segments.

7. Double click the left mouse button when you are finished drawing your Polygon ROI. This
will automatically connect your first and last line segments to form this multi-sided region
of interest.

To change the shape of a polygon ROI

1. Move the mouse over an
endpoint of a Polygon
ROI line segment until

the resize handle icon
appears.

2. Hold the left mouse
button down and drag
the end point to change the length or angle of the Polygon ROI line segment.

3. Release the mouse button to complete the change.

4. Repeat steps 1 through 3 to change additional line segments.

3.1.2 Moving an ROI Object
To Move an ROI:

1. Move the mouse over the desired ROI until the move icon  appears.

2. Hold the left mouse button down and drag the ROI to a new location on the image.

3. Release the mouse button to complete the move. Once the ROI has been moved, the ROI
Label will appear next to the ROI in the Active Thermal Window.
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3.1.3 Deleting ROI Objects

Deleting a Single ROI Object Using the Main Image Context Menu

The Delete ROI function allows you select and clear individual ROIs from the Image in the Active
Thermal Window.

To delete a Single ROI Object using the Main Image Context Menu:

1. Right click anywhere on the thermal
image in the Active Thermal
Window. This will reveal the Main
Image Context Menu.

2. Select Edit > ROIs > Delete ROI >
[select desired ROI you want to
delete].

3. Repeat steps 1 and 2 to delete additional ROIs.

Deleting a Single ROI Object Using ROI Tools

The ROI Chart found in the Active Tool Window provides an ROI Context Menu that allows you to
delete individual ROI objects. Once deleted, the ROI will no longer appear on the image in the
Active Thermal Window. All references to that ROI will also be removed from all views in the Active
Tool Window Viewer.

To delete a Single ROI Object Using ROI Tools

1. Select the ROI menu option
from the Active Tool Window
Drop-Down Menu.

2. Select the ROI Summary tab or
the select the tab for the ROI
type that would contain the ROI
you want to delete.

3. Right click on the row
containing the ROI you want to
delete. This will bring up the
ROI Context Menu of choices.

4. Click the Delete option for the ROI you selected.

5. Repeat steps 2 through 4 to delete additional ROIs.

Deleting All ROI Objects

The Delete all ROIs function will clear all ROIs from the Image in the Active Thermal Window. All
references to the ROIs will also be removed from all views in the Active Tool Window Viewer and
Pop-Up Tools.

To Delete All ROI Objects:

1. Right click anywhere on the thermal image in the Active Thermal Window. This will
reveal the Main Image Context Menu.

2. Select Edit > ROIs > Delete all ROIs.



LumaSpecTM Offline Analyzer User Manual Working With Thermal Tools  55

3.1.4 Working with the ROI Charts

LumaSpec Offline Analyzer provides ROI Charts  in the Active
Tool Window with details relating to each ROI as it appears in
the Active Thermal Window. The ROI Summary Tab contains
information relating to all ROIs as they appear in the Active
Thermal Window, while the Points, Lines, and Areas tabs
provide information relating to the ROIs that fall in those
categories.

All tabs contain columns of information regarding ROI Type,
ROI Label, Minimum temperature, Maximum temperature,
Average temperature. It also contains columns showing the
Standard Deviation for all the pixels temperatures in an ROI as
well as the Emissivity setting, Ambient temperature setting, and Delta T (if set) results for each ROI.

See section 3.1.5 for more information ROI Configuration Options.

Accessing ROI Charts

To access the ROI Charts Workspace Tool:

Select the ROI under Thermal in the View Pane.

3.1.5 Configuring ROIs
Once ROIs have been created, they may be configured individually or as a set by choosing different
colors, label types, and options. ROI configurations apply to ROIs as they currently appear in the
Active Thermal Window. ROI configuration settings do not carry forward to another camera or
image sequence view unless they are saved as an ROI Template file.

See section 3.1.6 for more information on Working with ROI Templates.

Accessing ROI Configuration Options

To access the configuration options for a single ROI using the Main Image Context Menu:

1. Right click anywhere on the thermal image in the Active Thermal Window. This will
reveal the Main Image Context Menu.

2. Select Edit > ROIs > Configure ROI > [select desired ROI you want to configure].

This will bring up the configuration
window for the individual ROI you
chose. If you choose a Rectangle ROI,
the window will be called Configure
Rectangle, and so on. Through this
window, you will be able to set
configuration options for the specific
ROI as currently displayed in the
Active Thermal Window.

To access the configuration options for all ROIs using the Main Image Context Menu:

1. Right click anywhere on the thermal
image in the Active Thermal Window.
This will reveal the Main Image Context
Menu.

2. Select Edit > ROIs > Configure all ROIs.
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This will bring up the Configure ROIs configuration window. Through this window, you will be able
to set configuration options for all ROIs as displayed in the Active Thermal Window.

A context configuration menu can be found in the ROI tab of the Active Tool Window Viewer and
through the ROI Pop-Up Tools. Using the ROI Context Menu, you will gain access to configuration
options for individual ROIs and for all ROIs as displayed in the Active Thermal Window.

To access configuration options for a single ROI using the ROI tools:

1. Select the ROI under Thermal on the View Pane.

2. Select the ROI Summary tab or the select the tab for the ROI type that would contain the
ROI you want to configure.

3. Right click on the row containing the ROI you want to configure. This will bring up the ROI
Context Menu of choices.

4. Click the Configure option for the
ROI you selected.

This will bring up the configuration
window for the individual ROI you
choose. If you chose a Rectangle ROI,
the window will be called Configure
Rectangle, and so on. Through this
window, you will be able to set
configuration options for the
specific ROI as currently displayed in
the Active Thermal Window.

See Section 3.1.5 for information on Working with ROI Configuration Options.

To access configuration options for all ROIs using the ROI tools:

1. Select the ROI menu option from the Active Tool Window Drop-Down Menu or from
the Pop-Up Tools Drop-Down Panel.

2. Right click on any row to bring up the ROI Context Menu of choices.

3. Click the Configure all ROIs
option.

This will bring up the Configure ROIs
configuration window. Through this
window, you will be able to set
configuration options for all ROIs as
displayed in the Active Thermal
Window.

See Section 3.1.5 for information on
Working with ROI Configuration Options.

Working with ROI Configuration Options

ROIs may be labeled in several different ways and displayed in different ROI Colors. You can choose
where you want the ROI Label Position and whether or not you want to Display ROI Label and/or
Display Temperature Data as part of the ROI Label. You also have the option of setting the
Emissivity value and Ambient Temperature associated with a single ROI or all ROIs.

For individual ROIs, you have the option of changing the name of the ROI Label to something more
descriptive. You also have the option of designating whether or not to use the ROI as an ROI
Reference for comparison against the temperature reading of other ROIs in the image.
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It is important to note that any ROIs configured through the ROI Configuration Window will only
apply to current ROIs as they appear in the Active Thermal Window. This configuration will not
apply to ROIs as they appear in other camera or image sequence views unless saved and loaded into
the other views as an ROI Template.

The ROI configuration also does not apply to any new ROI shapes as they are drawn in the Active
Thermal Window. The reason for this is that ROI shapes are based upon the default ROI setting you
established in the default ROI Options menu.

Note: The ROI configuration options only apply to current ROIs as they appear in the
Active Thermal Window.

These options do not apply to new ROIs nor do they apply to ROIs as they appear in other
image sequence views.

ROI Labels

ROIs are consecutively auto-labeled with numbers, starting with the
number one. However, a more descriptive ROI label can be set for
individual ROIs using numbers, letters or special characters.

To change the ROI Label using the ROI Configuration window:

1. Access the single ROI Configuration Options window using
the ROI Context Menu.

The ROI Label is an editable text field located at the top of the
configuration window.

2. Type in the new label, using any alphanumeric combination.

3. Select another option to be configured

OR,

Click OK to apply the ROI Label change and close out of the ROI
configuration window.

Note: The Reset to default settings button located at the bottom of the Configuration
Window will allow you to return to your last set of saved changes.

To change the ROI Label through the ROI Charts:

1. Click to select the ROI label you
want to change in the ROI Label
Column of the chart.

2. Click again to enable the editing
mode.

3. Type in the new label, using any
alphanumeric combination.

4. Repeat steps 1 through 3 to
change additional ROI Labels.

The new ROI Labels will also automatically
appear on the active image or image
sequence in the Active Thermal Window.
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ROI Label Position

The position of the ROI Labels can be set to appear above the ROI or below the ROI. They can also
be set so you have the ability to move the ROI Labels to other locations on the thermal image as
needed.

The ROI Label Position options can be applied to an individual ROI or to all ROIs as currently
viewed in the Active Thermal Window. They do not affect new ROIs nor ROIs as they appear in
any image sequence view.

Note: Individual ROI Labels can be moved on the image even if the configuration settings
have been set to top or bottom.

To change the position of the ROI Label:

1. Access the ROI Configuration Options window using
the ROI Context Menu.

The ROI Label Position choices are located directly under
the ROI Label editable text field.

2. Select either the Top, Bottom, or User Defined radio
button for the ROI Label Position.

The Top position will remain at the Top of the ROI
when the ROI is resized or moved to a new location in
the Active Thermal Window.

The Bottom position will remain at the Bottom of
the ROI when the ROI is resized or moved to a new
location in the Active Thermal Window.

The User Defined position is variable. It remains
separate from the ROI as the ROI is resized or moved
to a new location in the Active Thermal Window.
However, it does allow you to “grab” it with the
mouse and move it to any location on the thermal
image.

3. Select another option to be configured

OR,

Click OK to apply the ROI Position change and close out of the ROI configuration window.

Note: The Reset to default settings button located at the bottom of the Configuration
Window will allow you to return to your last set of saved changes.

To move an ROI Label on the Active Thermal Window:

1. Move the mouse over the ROI Label on the Active Thermal Window.

2. Hold the left mouse button down and drag the ROI Label to a new location on the image.

3. Release the mouse button to complete the move.

Once the ROI Label has been moved, it is no longer attached to the ROI Shape. If you change the
size of the ROI or move the ROI to a new position on the display, you will need to move the ROI
Label as well.



LumaSpecTM Offline Analyzer User Manual Working With Thermal Tools  59

Note: Once you have already moved an ROI Label, the ROI Label will not automatically
move with the ROI when you change the size of the ROI or move the ROI to a new position.

ROI Label Options

The ROI Label Options feature allows you to define whether or not you want to Display the ROI
Label and/or Display the Temperature Data for your current ROIs.

The ROI Label Options can be applied to an individual ROI or to all ROIs as currently viewed in the
Active Thermal Window. They do not affect new ROIs nor ROIs as they appear in any other camera
or image sequence view.

To set the ROI Label Options:

1. Access the ROI Configuration Options window using
the ROI Context Menu. The ROI Label Options choices
are located directly under the ROI Label Position options.

2. Click to mark the Display ROI Label checkbox if you want
to display the ROI Labels in the Active Thermal
Window

OR,

If already marked, click to unmark the Display ROI Label
checkbox if you do not want the ROI Labels to be
displayed.

3. Click to mark the Display Temperature Data checkbox if
you want to display the temperature data with the ROI in
the Active Thermal Window. Then select whether you
want the ROI Label to include the Minimum, Maximum,
or Average temperature data.

OR,

If already marked, click to unmark the Display
Temperature Data checkbox if you do not want the ROI
Temperature Data to be displayed.

4. Select another option to be configured

OR,

Click OK to apply the ROI Label Options changes and close out of the ROI configuration
window.

Note: The Reset to default settings button located at the bottom of the Configuration
Window will allow you to return to your last set of saved changes.

ROI Colors

The ROI Colors Section of the ROI Configuration window allows you to assign colors to your ROI
Labels as they appear in the Active Thermal Window. You have the ability to change the color of
the Border, Text, and Text Background. You also have the option to make the Background
Transparent and to Reset to the default color settings.

The ROI label colors can be applied to an individual ROI or to all ROIs as currently viewed in the
Active Thermal Window. They do not affect new ROIs nor ROIs as they appear in any other camera
or image sequence view.
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To set the ROI Colors:

1. Access the ROI Configuration
Options window ROI Context
Menu. The ROI Colors choices
are located directly under the
ROI Label Options.

2. Click the color bar for the
Border color bar to bring up
the Windows™ color dialog
box.

3. Select a new color for the
border of your currently
displayed ROIs.

4. Click OK to apply the color you have selected and to
close the dialog box.

5. Repeat steps 2 through 4 to change the color of the ROI
Text for your currently displayed ROIs.

6. Repeat steps 2 through 4 to change the color of your
ROI Text background

OR,

Click the Background Transparent checkbox to make your label background transparent.

7. Select another option to be configured

OR,

Click OK to apply the ROI Colors change and close out of the ROI configuration window.

Note: The Reset to default settings button located at the bottom of the Configuration
Window will allow you to return to your last set of saved changes.

ROI Emissivity & Ambient Settings

Emissivity is the ratio of the infrared energy radiated from the surface of a target to the infrared
energy radiated from a blackbody at the same temperature. The emissivity varies with the surface
condition of the object and also with temperature variation and wavelength. If this value is not
accurate, then true temperature cannot be measured. In other words, a variation or change in
emissivity will cause a change in the image results from the camera.

LumaSpec Offline Analyzer allows you to set individual emissivity values for each ROI or set a
general emissivity value that will apply to all ROIs. The software also allows you to take into account
the ambient temperature of the defined area.

Note: Emissivity and Ambient information for ROIs can be viewed through the ROI charts
found in the ROI Active Tool Window and ROI Pop-Up Tools.
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To set ROI Emissivity & Ambient values using the ROI Configuration Window:

1. Access the ROI Configuration Options window using the Main
Image Context Menu or the ROI Context Menu option.

The Emissivity & Ambient option fields are located to the right of
the ROI Label Position options.

2. Enter values in the Emissivity & Ambient fields of the
configuration window.

3. Select another option to be configured

OR,

Click OK to apply the Emissivity & Ambient value changes and
close out of the ROI configuration window.

To set ROI Emissivity & Ambient Values through the ROI Charts:

1. Select the ROI menu option
from the Active Tool
Window Drop-Down Menu
or from the Pop-Up Tools
Drop-Down Panel to open
the ROI Chart.

2. Click on the value you want
to change in the Emissivity
Column of the chart.

3. Type the new value and press
Enter.

4. Click on the value you want to change in the Ambient Column of the chart.

5. Type the new value and press Enter.

6. Repeat steps 2 through 5 to change Emissivity & Ambient values for additional ROIs.

The temperature values on the chart will automatically adjust in accordance with the new Emissivity
& Ambient values.

Working with ROI Reference

LumaSpec Offline Analyzer allows
you to define an ROI temperature
value as a reference temperature.
This ROI Reference (REF) is used to
calculate the difference between
the reference temperature and the
temperature readings of other ROIs
in the image. This temperature
difference is known as the Delta T.

The Delta T readings can be found
in the Delta C, Delta F, or Delta K
column of the ROI Chart. The
reference temperature will appear with an (R) next to it, while REF will appear in the Delta (C, F, or
K) column.

When a Point ROI is selected as a reference, the software will calculate the difference between the
maximum temperature of the point and the maximum temperature for each ROI in the image.
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When a line type or area type ROI is used, you need to select whether or not you want to the ROIs
Minimum, Maximum, or Average temperatures to be used in your Delta T calculations.

If you select the minimum temperature value of a line type or area type ROI to be used as a
reference, the resulting Delta T calculations will be based on the minimum value of each ROI in the
image. Likewise, if you select the maximum temperature value as your reference, the calculations
will be based on the maximum temperature of each ROI in the image. And, if you select the average
value of a line type or area type ROI as your reference, the resulting Delta T calculations will be
based on the average temperature of each ROI in the image.

To set the ROI Reference Using the Configuration Window

1. Access the ROI Configuration Options window
using the Main Image Context Menu or the ROI
Context Menu option.

The ROI Reference Options are located below the
Emissivity & Ambient options on the right side of the
configuration window.

2. Click to mark the ROI Reference Options checkbox. If
you have chosen a line type or area type ROI, then you
will also need to select whether you want the
Minimum, Maximum, or Average temperature data
to be used as the ROI Reference.

3. Select another option to be configured

OR,

Click OK to apply the ROI Reference Options change
and close out of the ROI configuration window.

Note: When using a Point ROI, the Delta T will be based on the maximum temperature
value of the Point ROI.

When using a line type or area type ROI, you will need to choose whether or not to base
the Delta T on the minimum, maximum, or average temperature value of the selected ROI.

To set the ROI Reference Using the Workspace Main Image Context Menu

1. Right click anywhere on the
thermal image in the Active
Thermal Window. This will
reveal the Main Image
Context Menu.

2. Select Set ROI Reference >
[select the desired ROI you
want to use as a Reference].

This will allow you to set the ROI
Reference for the selected ROI. If you selected a Point ROI, the comparisons will be based on the
maximum temperature value of the Point ROI.

If you selected a line type or area type ROI, you will need to choose whether or not to base your
comparisons on the minimum, maximum, or average temperature values of the selected ROI.
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To set the ROI Reference Using the ROI Context Menu:

1. Right click on the row for the ROI you want to
use as a reference. This will reveal the ROI
Context Menu.

2. Select Set [type and name of ROI] as
Reference.

This will allow you to set the ROI Reference for the
selected ROI. If you selected a Point ROI, the
comparisons will be based on the maximum temperature value of the Point ROI.

If you selected a line type or area type ROI, you will need to choose whether or not to base your
comparisons on the minimum, maximum, or average temperature value of the selected ROI.

To clear an ROI Reference

LumaSpec Offline Analyzer offers a number of methods to clear an ROI Reference. These methods
are as follows:

ROI Configuration Options Window

1. Access the ROI Configuration Options window using the Main Image Context Menu or
the ROI Context Menu option.

2. Click to unmark the ROI Reference Options checkbox.

3. Click OK to apply the change and close out the ROI Configuration Window.

ROI Context Menus

1. Right click anywhere on the thermal image in the Active Thermal Window to bring up the
Main Image Context Menu

OR,

Right click on the ROI chart in either the ROI Active Tool Window View or the ROI Pop-
Up Window to bring up the ROI Context Menu.

2. Select Clear ROI Reference

Note: You can also clear an existing ROI reference by creating a new ROI reference.

Reset to default settings

The Reset to default settings function of the ROI Configuration Options window allows you to
revert back to your last set of customized ROI configuration settings.

This feature only reverts back to your last saved settings in the configuration window and not the
Default ROI Options as set through the Options window.

See Section 2.12.2 for more information on Setting ROI Preferences.

3.1.6 Working with ROI Templates
When ROIs are created for one situation, it is often useful to apply the ROI information to other
situations as well. LumaSpec Offline Analyzer allows you to save and recall ROI Template files as
needed.

When an image or image sequence appears in the Active Thermal Window, it does not contain
any ROIs. With the ROI Templates feature, you have the ability to load a previously saved template
file to apply to your image or image sequence.
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When new ROIs are created or changes are made to existing ROIs, you have the ability to save the
information as a part of the existing ROI Template file or save the changes as a new ROI Template
file.

Saving an ROI Template File

To save an ROI template:

1. Right click anywhere on the thermal image in the Active Thermal Window. This will
reveal the Main Image Context Menu.

2. Select Save ROI Template.

Clicking Save ROI Template will bring up a standard Windows™
dialog box allowing you to save your file to your default ROI Collections folder or to
create a new folder in a directory of your choice.

If you want to save your template to a different location, select the new location before
proceeding to the next step.

3. Create a File Name for your ROI Template.

4. Click Save to save your ROI template.

Loading an ROI Template File

To load an ROI template:

1. Right click anywhere on the thermal image in the Active Thermal Window. This will
reveal the Main Image Context Menu.

2. Select Load ROI Template.

This will allow you to load your ROI Template from the ROI Collection Path you
previously established.

If you saved your template to a different location, you will be able to select the location
before proceeding to the next step.

3. Select the File Name for the ROI Template you want to load.

4. Click Open to open your ROI Template.

The saved ROIs will appear on the active image in the Active Thermal Window and will be
used for displaying the ROI data for that camera or image sequence.

3.2 Working with Isotherms
An isotherm is a simplified visual representation of the temperature breakdown on a thermal
image. LumaSpec Offline Analyzer’s Isotherm feature allows you to define up to eight temperature
ranges, replace each range with a single color, and apply the ranges/colors to the thermal image to
create a simplified Isotherm representation of temperature ranges.

3.2.1 Creating Isotherms
To create and apply an isotherm palette:

1. On the View Pane under Thermal, select
Isotherms.

2. The Isotherm Table will appear in the
Active Tool Window. Each row
corresponds to one of the eight available
Isotherm ranges. Enter a temperature
range, beginning with the lowest end of
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the range in the “Start” column and then the highest end in the “End” column.

3. Click the box under the Color column that corresponds to the row in which you are working.
A color palette appears. Choose a color to represent the temperature range you have
previously entered.

4. Once you have chosen the color you’d like to represent the range, check the box in the
column to the left of the starting temperature to apply the isotherm.

5. Add additional ranges as desired by repeating steps 2-4. Again, make sure to check the box
in the column to the left of the starting temperature to actually apply the isotherm.
Individual ranges may be turned on/off by checking and un-checking these boxes.
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3.2.2 Copying an Isotherm Image to the Windows™ System Clipboard
To copy an Isotherm:

Isotherm images may be copied to your
Windows™ clipboard by right-clicking the
Active Thermal Windowand choosing Copy>
and Copy IR Image or Copy IR Image with
Palette Bar. If the thermal image has an
associated visible image, the options Copy IR
and Visible Image and Copy IR and Visible
Image with Palette Bar will also be available in
the Copy menu.

If you choose to copy the image with the
palette bar, keep in mind that the altered Isotherm Palette Bar will be copied with the image.
Below is the copied isotherm image with Palette Bar.

Copied Isotherm image with palette bar
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3.3 Working with Line Profiles
LumaSpec Offline Analyzer offers a two-
dimensional Line Profile Graph, which
represents the temperature of each pixel
along a selected line type ROI. The graph
can be used to analyze temperature
information.

The graph always displays the
temperatures from the left to the right
side of the line. The X-axis displays the
number of pixels in the line and the Y-
axis displays the temperature value for each pixel in the line.

To use the Line Profile chart, you must open a sequence file and define Line ROIs. You may define
up to 10 Line Profiles using the pre-defined colors in the Line Profile chart.

3.3.1 Accessing the Line Profile Tool
To access the Line Profile Tools:

1. Open or select the tab of the thermal image sequence for which you
want to create a line profile.

2. Select Line Profile from the Thermal Menu on the View Pane.

3.3.2 Working with the Line Profile Graph
The Line Profile feature generates a two-dimensional graph (based on pixels and temperature)
using data from existing line ROIs on the live camera feed or image sequence as shown in the Active
Thermal Window.

To use the Line Profile feature, you must define Line type ROIs on the image appearing in the
Active Thermal Window. These line type ROIs can be any combination of straight lines, broken
lines, or free lines.

LumaSpec Offline Analyzer allows you to graph line profiles for up to 10 line type ROIs using the
preset colors in the Line Profile Selection Table.

Adding Line ROIs to a Line Profile

When you add previously created Line ROIs to the Line Profile Selection Table, they will appear
on the graph using the preset colors shown in the table. The Palette color at the top of the table
will show the line with the line color corresponding to the currently selected Temperature Palette
as shown in the Active Thermal Window.

To add individual line ROIs to the Line Profile:

1. Right click on the color that you would like your line to be on the Line Profile Graph.

2. Select Add Line and choose the ROI you would like to display from the list of existing line
type ROIs.

3. Repeat steps 1 and 2 to add additional ROIs.

When a line ROI is added to the Line Profile Selection Table, it will automatically appear in
the Line Profile Graph with the color you selected for that ROI.

To add all line ROIs to the Line Profile:

1. Right click on the Line Profile ROI Selection Table.

This will bring up the Line Profile ROI Selection Table Context Menu.
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2. Select Add All Lines to add all ROIs from the Line Profile Selection Table and Graph.

Removing Line ROIs from the Line Profile

Removing Line ROIs from the Line Profile will only affect the Line Profile Selection Table and Graph.
It will not affect the ROIs as they appear in the Active Thermal Window. To delete ROIs in their
entirety, refer to Section 3.1.3 Deleting ROI Objects.

To remove individual Line ROIs from the Line Profile:

1. Right click on the Line Profile ROI Selection Table.

This will bring up the Line Profile ROI Selection Table Context Menu.

2. Select Remove Line and choose the ROI you would like to remove from the list of existing
line type ROIs.

3. Repeat steps 1 and 2 to remove additional ROIs from the Line Profile Selection Table
and Graph.

To remove all line ROIs from the Line Profile:

1. Right click on the Line Profile ROI Selection Table.

This will bring up the Line Profile ROI Selection Table Context Menu.

2. Select Remove All Lines to remove all ROIs from the Line Profile Selection Table and
Graph.

Using the Line Profile Temperature Analysis Indicator Tool

The software provides a temperature analysis indicator tool in the form of a vertical line that allows
you to focus on specific temperatures for each ROI appearing across that line.

To add the Temperature Analysis Indicator Tool:

1. Move your mouse over the graph to display and
move the Temperature Analysis Indicator
Tool.

2. If desired, click the left mouse button to set the
Temperature Analysis Indicator Tool to a
fixed spot on the Line Profile Graph.

To move the Temperature Analysis Indicator Tool from
its fixed position:

1. Position the mouse over the Temperature
Analysis Indicator Tool.

2. Click the left mouse button to unlock the tool
from its fixed position.

3. Move your mouse over the graph to move the Temperature Analysis Indicator Tool to a
new location on the graph.

4. If desired, click the left mouse button to set the Temperature Analysis Indicator Tool to
its new spot on the Line Profile Graph.

To remove the Temperature Analysis Indicator Tool from the Line Profile Graph:

1. Position the mouse over the Temperature Analysis Indicator Tool.

2. Click the left mouse button to unlock the tool from its fixed position.

3. Move your mouse over the graph to move the Temperature Analysis Indicator Tool to
the side of the graph.

Temperature
Analysis

Indicator Tool
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3.3.3 Modifying a Line Profile Graph
LumaSpec Offline Analyzer provides a number of functions that allow you to customize the Line
Profile Graph according to your specific needs.

Setting the Line Profile Temperature Range

The LumaSpec Offline Analyzer Line Profile Graph uses the same temperature range as the Active
Thermal Window shown in the Tool Pane.

To adjust the Temperature Range values:

1. Click on one of the ends of the Temperature scale in the Tool Pane and drag it to the
temperature desired.

2. Repeat for the other end to create the desired temperature range.

3.3.4 Copying a Line Profile Image to the Windows™ System Clipboard

It is often necessary to save a Line Profile Image for further analysis and/or reporting purposes. By
copying a Line Profile Image to the Windows™ System Clipboard, it can be viewed and saved as a
Windows™ System Clipboard image.

It can also be pasted into programs outside of the LumaSpec Offline Analyzer software.

To copy the Line Profile Image:

1. Right click anywhere on the Line Profile Graph to reveal the Line Profile Graph
Context Menu.

2. Select Copy > Copy Line Profile Image.

Once you have copied the Line Profile Image, it is saved to the Windows™ System Clipboard
where it can be viewed or saved through the Windows™ System Clipboard Viewer. It can
also be pasted into programs outside of the LumaSpec Offline Analyzer software.

3.4 Working with ROI Trends
LumaSpec Offline Analyzer offers a
two-dimensional time vs.
temperature graph, which can
display the minimum, maximum, or
average temperature of multiple ROI
channels. The Trend graph can be
used to analyze temperature
information.

The X-axis represents the time in
seconds or number of frames that
have passed through the Active Thermal Window for live image feeds and image sequences. The Y-
axis represents the user-selected Minimum, Maximum, or Average temperature of the selected ROIs.

3.4.1 Accessing the ROI Trend Graph
To access the ROI Trend Graph:

Select ROI Trend under Thermal on the View Pane.

3.4.2 Creating an ROI Trend Graph
The Trend feature generates a two-dimensional graph (based on time and temperature) using data
from existing ROIs on a thermal image sequence.
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To use the Trend graph, you must define ROIs on the image. These ROIs can be any combination of
points, line type ROIs, or area type ROIs. LumaSpec Offline Analyzer allows you to define Trends for
up to 10 ROI channels using the preset colors.

Adding ROI Temperatures to an ROI Trend

When you add previously created ROIs to the ROI Trend ROI Selection Table, they will appear on
the Trend graph using the present colors shown in the table. The “Palette” color at the top of the
table will show the line with line color corresponding to the currently selected Temperature Palette.

To add individual ROI Data to the Trend:

1. Right click on the color that you
would like to appear on the Trend
graph.

This will bring up the ROI Trend
Context Menu.

2. Select Add ROI and choose the ROI
you would like to display from the
list of existing line type ROIs.

3. Select the Minimum, Maximum,
or Average temperature of that ROI to be displayed in the Trend Graph.

Point ROIs will automatically be displayed with their Maximum temperature values.

4. Repeat steps 1 through 3 to add additional ROI data.

When ROI data is added to the Trend ROI Selection Table, it will automatically appear in the
Trend Graph with the color you selected for that data.

Removing ROI Data from the ROI Trend

Removing ROI data from the Trend ROI Selection Table will only affect the Trend ROI Selection
Table and Graph. It will not affect the ROI as it appears in the Active Thermal Window. To delete an
ROI in its entirety, refer to Section 3.1.3 Deleting ROI Objects.

To remove individual ROI data from the Trend:

1. Right click on the Trend ROI Selection Table.

This will bring up the ROI Trend Context Menu.

2. Select Remove ROI and choose the ROI data you would like to remove from the chart.

3. Repeat steps 1 and 2 to remove additional ROI data.

To remove all ROI data from the Trend:

1. Right click on the Trend ROI Selection Table.

This will bring up the ROI Trend Context Menu.

2. Select Remove All ROIs.

3.4.3 Viewing Details in an ROI Trend Graph
Once ROI data is plotted as a line on the graph, it shows the temperature fluctuations along the line
over time. The temperatures from an image sequence are viewed as captured.

Using the ROI Trend Temperature Analysis Indicator Tool

The software also provides a temperature analysis indicator tool in the form of a vertical line that
allows you to focus on specific temperatures for each ROI appearing across that line.
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To add the ROI Temperature Analysis Indicator Tool:

1. Move your mouse over the graph to display and move the Temperature Analysis
Indicator Tool.

2. If desired, click the left mouse button to set the Temperature Analysis Indicator Tool to
a fixed spot on the ROI Trend Graph.

To move the Temperature Analysis Indicator Tool from its fixed position:

1. Position the mouse over the Temperature Analysis Indicator Tool.

2. Click the left mouse button to unlock the tool from its fixed position.

3. Move your mouse over the graph move the Temperature Analysis Indicator Tool to a
new location on the graph.

4. If desired, click the left mouse button to set the Temperature Analysis Indicator Tool to
new fixed spot on the ROI Trend Graph.

To remove the Temperature Analysis Indicator Tool from the Trend Graph:

Uncheck the Enable Indicator checkbox located in the upper right panel above the Trend
ROI Selection Table.

3.4.4 Modifying an ROI Trend Graph

LumaSpec Offline Analyzer provides a number of functions that allow you to customize the Line
Profile Graph according to your specific needs.

Setting the Trend Graph Temperature Range

The LumaSpec Offline Analyzer ROI Trend Graph uses the same temperature range as the Active
Thermal Window shown in the Tool Pane.

To adjust the Temperature Range values:

1. Click on one of the ends of the Temperature scale in the Tool Pane and drag it to the
temperature desired.

2. Repeat for the other end to create the desired temperature range.

3.4.5 Copying an ROI Trend Image to the Windows™ System Clipboard

It is often necessary to save a Trend Image for further analysis and/or reporting purposes. By
copying a Trend Image to the Windows™ System Clipboard, it can be viewed and saved as a
Windows™ System Clipboard image.

It can also be pasted into programs outside of the LumaSpec Offline Analyzer software.

To copy the ROI Trend Image::

1. Right click anywhere on the ROI Trend Graph to reveal the ROI Trend Graph Context
Menu.

2. Select Copy > Copy ROI Trend Image.

Once you have copied the Trend Image, it is saved to the Windows™ System Clipboard
where it can be viewed or saved through the Windows™ System Clipboard Viewer. It can
also be pasted into programs outside of the LumaSpec Offline Analyzer software.
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3.5 Working with Line Profile Trends
The Line Profile Trend feature generates a three-dimensional
representation, based on distance and temperature, of the surface
of user-defined Line ROI on a thermal sequence.

3.5.1 Accessing the Line Profile Trend
To use the Line Profile Trend chart, you must first define Line ROIs.

To access the Line Profile Trend:

Select Line Profile Trend under Thermal on the View Pane.

3.5.2 Creating a Line Profile Trend
To create a line profile trend:

1. Open or select the tab of the thermal image for which you wish to create a Line Profile
Trend.

2. Select Line Profile Trend under the Thermal menu on the View Pane.

3. A blank line profile trend appears:

4. Select a previously created Line ROI from the Line Profile ROI drop-down box to see it
rendered in 3D on the graph. A 3D representation of the temperature data along the ROI
will appear in the pre-set palette colors.

Note: You may need to resize the Active Thermal Window in order to see the entire line
profile trend. To do this, click and drag on the gray horizontal divider between Active
Thermal Window and the Active Tool Window.
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To create a line profile trend from a sequence:

1. Open or select the tab of the sequence for which you wish to create a Line Profile Trend.

2. Select Line Profile Trend under the Thermal menu on the View Pane.

3. An ROI graph displays a series of slices representing each frame in 3D:

If you are viewing a static image or if the sequence is stopped, only one slice will appear:

You can change the Orientation of the 3D Line Profile Trend by clicking the radio buttons below
the 3D graph: Bottom Left (default), Bottom Right, Top Left, and Top Right:

The Reset button clears the 3D graph but preserves your orientation and Line ROI selections.
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3.5.3 Copying a Line Profile Trend to the Windows™ System Clipboard

It is often necessary to save a 3D Image or Line Profile Trend for further analysis and/or reporting
purposes. By copying a 3D Image to the Windows™ System Clipboard, it can be viewed and saved as
a Windows™ System Clipboard image.

It can also be pasted into programs outside of the LumaSpec Offline Analyzer software.

To copy the 3D Image:

1. Right click anywhere on the 3D Graph to
reveal the 3D Graph Context Menu.

2. Select Copy > Copy Trend Image.

Once you have copied the Trend Image, it is
saved to the Windows™ System Clipboard
where it can be viewed or saved through the
Windows™ System Clipboard Viewer. It can also be pasted into programs outside of the
LumaSpec Offline Analyzer software.

3.6 Working with Histograms
The LumaSpec Offline Analyzer Histogram
Tool gives you an indication of the distribution
of temperature values within the thermal
image.

The X-axis of the histogram represents pixel
intensity and the Y-axis represents the percent
of color count for each pixel intensity value.
See the example of a histogram below.

3.6.1 Accessing the Histogram Tool
To access Histogram:

Select Histogram under Thermal on the View Pane.

3.6.2 Creating a Histogram Chart

Creating ROI Histogram Views

When a Histogram is opened, it is based on the
Entire Image by default. However, the
software provides you with the ability to
change the Histogram view based on a specific
ROI.

To create ROI Histogram views, you must first
define ROIs on the image as it appears in the
Active Thermal Window.

To create ROI Histogram Views:

1. Define ROIs on the image in Active Thermal Window.

2. Open the Histogram Chart.

3. Click the Histogram Region selection box to expose the drop-down list of available views.

4. Select the Histogram Region you would like to chart.
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The histogram immediately changes to reflect the new distribution of pixel intensity that
exists within the selected Region of Interest.

3.6.3 Setting the Appearance of the Histogram Graph

Selecting a Histogram Measurement Range

You may use the Histogram Range
Selection Slider Bar to narrow the
range of pixels being measured. Once
set, the Range and Pixel Count located
beneath the graph will automatically
adjust according to the Range
Selection Slider Bar settings.

The Upper Slider Bar Handle sets
the upper limit temperature for the
range. The Lower Slider Bar Handle
sets the lower limit temperature for the range. The Slider Bar allows you adjust the temperature
span within the defined temperature range.

To Adjust the Histogram Range:

1. Click and hold the Upper Temperature Slider Bar handle as you slide the handle to the
desired upper limit temperature reading for the range. This will set the Range High
vertical bar on the graph.

2. Click and hold the Lower Temperature Slider Bar handle as you slide the handle to the
desired lower limit temperature reading for the range. This will set the Range Low vertical
bar on the graph.

3. If desired, click, hold, and move the center of the slider bar to adjust the span as needed.

To reset the range back to original values:

Click the Reset button located at the bottom of the Slider Bar.

3.6.4 Copying a Histogram Image to the Windows™ System Clipboard

It is often necessary to save a Histogram Image for further analysis and/or reporting purposes. By
copying a Histogram Image to the Windows™ System Clipboard, it can be viewed and saved as a
Windows™ System Clipboard image.

It can also be pasted into programs outside of the LumaSpec Offline Analyzer software.

To copy the Histogram Image:

1. Right click anywhere on the Histogram to reveal the Histogram Context Menu.

2. Select Copy > Copy to Clipboard.

Once you have copied the Histogram Image, it is saved to the Windows™ System Clipboard
where it can be viewed or saved through the Windows™ System Clipboard Viewer. It can
also be pasted into programs outside of the LumaSpec Offline Analyzer software.
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3.7 Working with 3D Profiles
The LumaSpec Offline Analyzer 3D Profile provides a three-dimensional representation of pixel
intensity values within a thermal image that is generated from a loaded sequence as it appears in
the Active Thermal Window.

LumaSpec Offline Analyzer 3D View Panel

Note:
X Axis = Pixel Width

Y Axis = Pixel Height

Z Axis = Temperature

3.7.1 Accessing the 3D Profile Tool
To access the 3D profile tool:

Select 3D Profile under Thermal on the View Pane.

3.7.2 Working with 3D Profile Tool

Changing the Active Tool Window 3D Orientation

To Change the Workspace 3D Orientation View

Click to mark the Bottom Left, Bottom Right, Top Left, or Top Right
orientation view.

3.7.3 Copying a 3D Profile Image to the Windows™ System Clipboard
It is often necessary to save a 3D Profile image for further analysis and/or reporting purposes. By
copying a 3D Profile image to the Windows™ System Clipboard, it can be viewed and saved as a
Windows™ System clipboard image with or without the Palette Bar attached.

It can also be pasted into programs outside of the LumaSpec Offline Analyzer software.

To copy the 3D Profile Image using the 3D Profile Workspace and Pop-Up Tools:

1. Right click anywhere on the 3D Profile to reveal the 3D Profile Context Menu.

2. Select Copy > Copy 3D Profile.
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OR,

Select Copy > Copy 3D Profile with Palette.

Once you have copied the 3D Profile image, it is saved to the Windows™ System Clipboard
where it can be viewed or saved through the Windows™ System Clipboard Viewer. It can
also be pasted into programs outside of the LumaSpec Offline Analyzer software.
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4 Working with Image Manipulation Tools

4.1 Working with Image Blender
The Image Blender feature of LumaSpecTM Offline Analyzer allows the creation of a composite
blended thermal and visible image. The Temperature Range Slider Bar allows you to control the
area of the overlaid thermal image based on temperature.

4.1.1 Accessing Image Blender
1. Open an image file or select the tab of a previously opened image that contains both a

thermal and visible image file.

Note: If the thermal image doesn’t have a visible image, you can attach one. See Section
2.4.3 for Loading a Visible Image, for information about adding a visible image to the file.

2. Click on the Image Blender selection under the Image
Manipulation header on the View Pane.

3. The Active Thermal Window contains the thermal image
and will show the composite image as you define it. The
Active Tool Window contains both the thermal and visible
images and tools to line up and rotate the thermal image
over the visible image.
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Note: You can modify the brightness and contrast of a Visible Image by clicking on the
Brightness and Contrast feature of the Tool Pane. See Section 2.8.5 Brightness/Contrast, for
more information about altering the brightness and contrast of a visible image.

4.1.2 Lining Up the Thermal and Visible Images
Lining up the thermal and visible images is important in order for the thermal and visual data to
correspond as they should. Use a combination of the Temperature Range Slider Bar (to the left
of the thermal image), the fusion feature (changes the slider bar when the Use fusion box is
checked), the Rotation Buttons (underneath the visible image), and the Cropping Box on both
the visual and thermal images to line up the images.

Using the Temperature Range Slider Bar

Use the Temperature Range Slider Bar to determine which range of
pixels (and their corresponding color scheme) you want to be visible over
the visible image. The upper Slider Bar Handle controls the maximum
temperature visible. The lower Slider Bar Handle controls the minimum
temperature visible.

Try to choose a few distinct thermal features that you can match to
edges, borders, or shapes on the visible image. You may adjust the
overall Temperature Palette or Temperature Palette Color Scheme for
the best visibility.

If you are unhappy with the results of your adjustment, click the Reset
button provided at the bottom of the Temperature Range Slider Bar for
a full reset back to the original Maximum and Minimum temperatures.

Using Fusion

The fusion feature allows the actual blending of the thermal image with a grayscale version of the
visible image.

To use the fusion feature:

1. Check the Use fusion box below the thermal image in the Active Tool Window. The
Temperature Range Slide Bar becomes a fusion Slider Bar and now controls the percentage
of the thermal image showing.
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The IR image percentage is controlled by sliding the fusion Slider Bar:

The fusion Slider Bar controls the percentage of IR image showing over the visible image. See
examples of the different percentages below.
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Using Rotation Buttons

The Rotation Buttons are located below the visible
image in the Active Tool Window. They allow you to
rotate the visible image only, in increments of 45°, 5°
and 0.5°, either clockwise or counterclockwise.

To undo a rotation choice (for example, Rotate 5°
CCW), simply choose the opposite button (Rotate 5°
CW), or hit the RESET button in the middle of the set.

A line of text underneath the visible image displays the
Current Rotation of the image. To rotate 10° CCW, hit
the Rotate 5° CCW button twice, and so forth.

Using Cropping Boxes

Both the visual and thermal images may be cropped
using the green Cropping Boxes that outline both the
visual and thermal images shown in the Active Tool
Window.

To adjust a cropping box:

1. Click on the image you wish to crop--either the visual or
thermal image. A white, dashed line indicating selection
should appear around the selected image.

2. Position the mouse over one of the corners or sides of the
image. The mouse will change to a double-headed arrow.

3. Left-click and drag the green border. It will turn to a white
border with corner handles for adjustment. Watch as the
image in the Active Thermal Window changes to correspond
with the cropping box you are adjusting below in the Active
Tool Window.

4. Adjust the thermal and visible images as desired. You can
move the cropping box to a different part of the thermal or
visible image by putting your mouse in the center of the box,
where it will turn into a quad-arrow moving tool, and
clicking and dragging until the box is where in the desired
position.

Note: Use a combination of the Temperature Range Slider Bar, fusion Feature, Rotation
Buttons and Cropping Boxes to adjust and nudge the images into very close alignment. The
best results may be achieved by switching between tools several times as you make fine
adjustments.
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The thermal image being cropped in the Active Tool Window below is affecting the composite
image in the Active Thermal Window Above.

4.1.3 Copying Blended Images
You may copy the Blended Image to the Windows™
clipboard for use in other applications.

To copy blended images:

1. Right-click on the composite image in the Active
Thermal Window.

2. Choose Copy Blended Image or Copy
Blended Image with Palette Bar. This copies
the image to your Windows™ clipboard where it
may be pasted into the program of your choice.

4.2 Working with Mosaic Creator
The Mosaic Creator feature of LumaSpec Offline Analyzer allows you to create a larger thermal
image by “stitching” together several smaller thermal images. LumaSpec Offline Analyzer uses
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mathematical formulas to average thermal data where individual images overlap. You can rotate
and overlap images to line them up accurately.

4.2.1 Accessing Mosaic Creator
To access Mosaic Creator:

1. Open the images that you would like to stitch together.

2. Click Mosaic Creator under Image Manipulation on the
View Pane.

Initially, the phrase “No Mosaic Image Available” displays
in the Active Thermal Window. Images must be added to
the Mosaic Creator.

4.2.2 Adding Images to the Mosaic Creator
To add images to the Mosaic Creator:

1. Right-click the Rotation Tools
displayed in the Active Tool
Window of Mosaic Creator.

2. You may add images one at a time
by choosing Add image… or you
may Add all Open Images at
once.

3. After adding all open images (in
this case, four images), the display
looks like this:

4.2.3 Creating a Mosiac Image
Individual images may be arranged as desired. The Mosaic Work Area expands to fit the images as
they are arranged. You may also expand the Active Tool Window to increase the Mosaic Work Area
by clicking and dragging the bar that splits the Active Thermal Window and the Active Tool
Window:
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To create a Mosaic image:

1. Arrange the images as accurately as possible.

Note: Lining up images is tricky because they are not transparent. One way to easily line
up images is to quickly click back and forth between the top and bottom images. This
allows you to perform subtle adjustments.
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Rotate individual images to better line them
up. In the screen shot to the right, the upper
right image is being rotated counter clockwise
to line up the tree line in the background. The
black border that appears has a temperature
value of absolute zero and will not affect the
temperature averaging between images.

3. Once the images are arranged to your
satisfaction, click and drag the green bordered
box to crop the image as desired. The area
defined by this box will determine the final
area of the created mosaic.

4. Right-click within the Active Tool Window (try
not to click your thermal images, as you will
cause the one you click to come to the front),
and choose Create Mosaic Image.

5. LumaSpec Offline Analyzer stitches
multiple images together, averaging
temperature data and displays a
progress dialog box.
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6. The final Mosaic Image is created and displayed in the Active Thermal Window:

To copy the mosaic image to the WindowsTM clipboard:

1. Right-click on the composite
Mosaic image in the Active
Thermal Window

2. Select Copy Mosaic Image or
Copy Mosaic Image with
Palette Bar (to include
Temperature Palette Bar to the
right of the Mosaic Image). You
can also save the mosaic image
as a new Thermal image file by
selecting Save Mosaic Image.

3. When you have copied the
image to your Windows™
clipboard, you may paste it into the program of your choice.



LumaSpecTM Offline Analyzer User Manual Working with Image Manipulation Tools  88

4.3 Working with Image Subtractor
Image Subtractor is a feature of LumaSpec Offline Analyzer that subtracts one thermal image from
another, producing a third, resulting thermal image with subtracted thermal data.

Image Subtractor can be used to produce a true Delta T thermal image, unaffected by ambient
temperature, by subtracting an image of ambient temperature from an image depicting a
temperature change. In this example, the first and last frames of a sequence showing a heating
condensor will be used. However, any thermal image may subtracted from another.

4.3.1 Using Image Subtractor
To subtract one image from another:

1. Open the image you will subtract from. In this case, an .RTV sequence file is opened, and the
last frame is selected using the Sequence Control Panel.

2. Select Image Subtractor under Image Manipulation on the View Pane panel.

3. The first image will appear in the Image Subtractor in the Active Tool Window. The
Active Thermal Window will eventually display the subtracted image, but for now
displays the text No subtraction output to display.
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4. Open the image you would like to subtract from the first image. In this case, the first frame
(depicting ambient) of the current .RTV sequence file is selected using the Sequence
Control Panel. To select a new frame in the sequence, click ROI under Thermal on the
View Pane. This will allow you access to the sequence again outside the Image Subtractor
view.

5. Once the second image is open (or the desired frame is achieved within the sequence), go
back to the Image Subtractor View by clicking on Image Subtractor under Image
Manipulation. You may also click on the View Tabs on the bottom of the user interface
for easy navigation between views.

6. Right-click on the instructional text next to the first picture in the Image Subtractor Active
Tool Window. Choose Image to Subtract, and then choose the file or sequence name
from the list of open files shown.

7. Right-click on either image in the Active Tool Window, and choose Create Subtracted
Image.

8. The subtracted image appears in the Active Thermal Window. The temperature data
contained and portrayed in this image is the true Delta T measured in the sequence. You
may adjust the subtracted image’s temperature palette bar as well.

To copy the subtracted image to the WindowsTM clipboard:

1. Right-click on the composite Mosaic
image in the Active Thermal Window

2. Select Copy Mosaic Image or Copy IR
Image with Palette Bar. You can also
save the mosaic image as a new Thermal
image file by selecting Save Mosaic
Image.

3. When you have copied the image to your
Windows™ clipboard, you may paste it
into the program of your choice.
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5 Using the Report Queue

The Report Queue is a temporary queue that acts as a
bridge between LumaSpecTM Offline Analyzer and
LumaSpec Offline Analyzer Report Writer. You may send
images to the Report Queue and, within the Queue, edit
the order of images.

After launching Report Writer from within LumaSpec
Offline Analyzer, the queue can be used to quickly create
a multi-page report using a general or customized Report
Template. Report Queues may also be saved and loaded.

The Report Queue consists of two areas—a main viewing
area showing the selected thermal image and a scrollable
display along the left side showing each image that has
been added to the Report Queue. Below the main display
are buttons that allows you to edit the order and amount
of thermal images within the Queue.

5.1 Adding Files to the Report Queue
When a file is added to the Report Queue, the thermal image is added, along with the
corresponding visible image (if applicable). In addition, Histogram and 3D Profile information are
generated, and a Line Profile is added if you have generated this data. ROI data is also
automatically added, and ROIs are displayed on the main thermal image for each file. Other types
of images created in LumaSpec Offline Analyzer, like Blended Images or Mosaics, must be added as
separate “images” to the Report Queue, as these types of images have their own specific thermal
data.

5.1.1 Adding a Thermal Image to the Report Queue
There are two ways to add images to
the Report Queue. You may use the
Text Menu or the Tool Bar.

To add an image to the Report Queue:

1. Select the image you wish to
add to the Report Queue.
Open the file if it is not already
active, or select the appropriate
File Tab to reveal the image in
the Active Thermal Window.

2. Easily add the image to the
Report Queue by using the Add File to Report Queue tool bar
button.

OR
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Use the expandable Report Writer tool bar button and choose Add file to Report
Queue.

OR

Use the Report Writer text menu and select Add file to Report Queue.

The Status Bar in the lower left of LumaSpec Offline Analyzer’s user interface will display
that the file has been added to the Report Queue.

To view/edit the Report Queue:

1. Select the Report Writer tool bar button and choose Edit Report Queue (You can access
the same expandable menu through the Report Writer text menu.)
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2. The queue appears with the file added and ready to be edited.

5.2 Editing the Report Queue
Within the Report Queue, you may change the type of data displayed below the thermal image,
and you may also change the order of the images within the Queue.

5.2.1 Changing Data Displayed Below the Thermal Image
The corresponding visual image is the default display below the featured thermal image in the
Report Queue. However, you may choose to display the thermal images Histogram, Line Profile, or
3D Profile instead. This change affects all the images in the Queue, but it is easy to switch between
settings. The Report Queue remembers the last option chosen when the Queue is closed, and when
it is re-opened, the same data is displayed below the main thermal image.
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To change the data displayed below the thermal image:

1. Right-click anywhere within the Report Queue.

2. You will see a menu with five choices: Visible, Histogram, Line Profile, 3D Profile, and
Blended Image. (Histogram and 3D Profile are automatically generated, but Line Profile and
Blended Image will need to have been created in order to appear in the Report Queue.)
Select the appropriate item. For this example, we selected Histogram.

3. Now each thermal image is shown with its Histogram displayed below. The Queue will
remember this setting (unless changes are made before it is saved), and when the Queue is
re-opened, it will again display the thermal images with corresponding Histograms.

If the image you select has not been created, the Report Queue will display only the
centered thermal image and the sentence No image available.
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5.2.2 Changing the Order of Images Within the Queue
The Report Queue allows you to change the order of the images within the Queue using the editing
buttons at the bottom of the main Report Queue display.

Move up 25 items Moves an image up 25 items in the Report Queue order.

Move up 5 items Moves an image up 5 items in the Report Queue order.

Move up 1 item Moves an image up 1 item in the Report Queue order.

Send selected item to...
Brings up a window which allows you to type in the
number corresponding to the placement they desire for
the image.

Open Image
Opens a Report Queue image in LumaSpec Offline
Analyzer.

Delete Image
Removes the thermal image from the Queue. You are
asked to confirm, as this is permanent.

Move down 1 item Moves an image down 1 item in the Report Queue order.

Move down 5 items Moves an image down 5 items in the Report Queue order.

Move down 25 items Moves an image down 25 items in the Report Queue order.

5.2.3 Deleting Images Within the Queue
To remove an image from the Report Queue:

1. Select the image to remove from the scrollable list on the left of the Report Queue
Window.

2. Click the Delete Image button (located between the Send Selected Item To and Move
Down One Item buttons at the bottom of the main Report Queue display).

3. A warning will appear asking if you want to remove
this image from the Report Queue.

If you have selected the right image, click OK. The
image disappears from the scrollable list at the left.
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5.3 Saving a Report Queue
Once you have configured your Report Queue the way you want it, you have the option of saving it
so that you can return to it later.

To save a Report Queue:

1. Either click on the Report Writer tool bar button or the Report Writer text menu and choose
Save Report Queue or click on the Report Writer text menu and select Save Report
Queue.

2. The “Save As” Windows™ dialog box appears.

3. Choose a name and location for your file; the .MSQ extension will be automatically added.

4. Click Save.

5.4 Opening a Saved Report Queue
You can open a previously saved Report Queue to continue working on it or to modify it for other,
similar projects.

To Open a Report Queue:

1. Either select the Report Writer tool bar button and choose Open Report Queue or click on
the Report Writer text menu and select Open Report Queue.

2. If you already have items in your Report Queue, a dialog box will appear warning you that
these items will be overwritten. If you do not wish to preserve your current Report Queue,
click Yes. Otherwise, click No and save your current Report Queue using the steps described
above.
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3. A standard Windows™ dialog box appears.

4. Select the file you wish to open and click Open.

To see the newly loaded Report Queue, either select the Report Writer tool bar button and
choose Edit Report Queue or click on the Report Writer text menu and select Edit Report
Queue.
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To ensure consistent document formatting, this page was intentionally left blank.
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6 Using the Report Writer

The LumaSpecTM Offline Analyzer Report Writer is designed to provide you with a powerful, yet
simple and user-friendly means for creating professional-quality reports based on data collected by
your LumaSpec Offline Analyzer software. You can either run the Report Writer as a stand-alone
word processing program or simultaneously with your LumaSpec Offline Analyzer software.

Note: The LumaSpecTM Offline Analyzer Report Writer is compatible with Microsoft Word
(.doc format).

6.1 Accessing the Report Writer
1. Click on the Report Writer text menu and choose

Report Writer. You may also use the
corresponding toolbar button or the
corresponding text command (Ctrl +R).

OR

To launch the Report Writer independently,
simply go to the All Programs area of your
Windows™ Start menu, and choose LumaSpec
Offline Analyzer, then Report Writer.

Note: When you launch the Report Writer from within LumaSpec Offline Analyzer, the
Report Writer software establishes links to the LumaSpec Offline Analyzer program to
enables data input directly from the LumaSpec Offline Analyzer program. When you
launch the Report Writer independently, it does not link to the LumaSpec Offline
Analyzer program in this way, and the same data must be inserted again.

6.2 Using the Report Writer
When the Report Writer is opened, the software automatically opens a new blank document. The
Report Writer features standard Windows™ text menus at the top of the user interface. A toolbar
and paragraph bar are located under the text menus for quick access to the software’s tools and
editing features.

6.3 Text Menus
6.3.1 File
This program has a standard Windows™ File menu, with standard Windows™ document
commands.

Text Menu

Toolbar

Paragraph Bar
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New (Ctrl + N) Creates a new blank report

Open (Ctrl + O) Opens an existing report

Close (Ctrl + F4) Closes the current file

Save (Ctrl + S) Saves the current file, overwriting any previously saved versions

Save As Saves the current file with with the option to give it a new name

Page Setup (Ctrl + G) Allows you to select page size, orientation, and margins for the current
report document

Print (Ctrl + P) Prints the current document

Print Preview A new window opens showing the document as it will print on the page

Return to LumaSpec Exits entire program

Exit Exits entire program

6.3.2 Edit
Undo Input (Ctrl + Z) Allows you to undo your last action in the program

Redo Allows you to redo something just undone

Cut (Ctrl + X) Removes selected text/image while copying it to the clipboard

Copy (Ctrl + C) Copies an image or data to the clipboard

Paste (Ctrl + V) Pastes an image or data from the clipboard

Delete (Del) Deletes the selected item

Delete Page Deletes the current page

Search (Ctrl + F) Finds text within a report. Choose the search direction (within text) and you
may also choose case-matching by checking the appropriate box.

Replace (Ctrl + H) Finds and replaces text within a report. Replace words/phrases one at at a
time, or choose to “Replace All” at once.

Select All (Ctrl + A) Selects everything on the page for easy cutting/copying.

6.3.3 View

Normal Layout The edges of the page extend to the edges of the Report Writer Window

Page Layout Shows the page edges at the top and right side of the Report Writer Window

Centered Page
Layout

Reveals all page edges, centering the page within the Report Writer Window

Headers and Footers Allows you to create/edit headers and footers for the current report

Tool Bar Shows/hides the Tool Bar at the top of the Report Writer interface

Paragraph Bar Shows/hides the Paragraph text-editing fields/buttons

Ruler Shows/hides the ruler at the top of the current page

Status Bar Shows/hides the information at the bottom of the page (page number, line
number, column number, zoom percentage, overwrite (on/off), caps lock
(on/off), number lock (on/off)

Control Characters Shows/hides invisible text formatting characters

Zoom Choose from several zoom levels
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6.3.4 Insert

Note: Reveal the Insert menu by right-clicking with your mouse anywhere in the Report
Writer file. Edit an inserted object by right-clicking on a selected image, object, or a text
selection.

LumaSpec

This submenu allows you to import many specific kinds of data directly from the LumaSpec Offline
Analyzer program. You can import a Template, Thermal Image, Isotherm, Region of Interest (ROI)
data, a Line Profile, a 3-D Profile, or a Histogram.

Note: This “LumaSpec Offline Analyzer”
submenu is only available if you’ve launched
Report Writer from within LumaSpec Offline
Analyzer. See instructions for launching the
Report Writer within LumaSpec Offline Analyzer,
at the beginning of Section 4. You must
generate data in LumaSpec Offline Analyzer
before you can import it into the Report Writer.
For example, if you select Insert > LumaSpec
Offline Analyzer > Line Profile before you actually perform a line profile on a thermal
image, the Report Writer software will display the prompt above. You must return to
LumaSpec Offline Analyzer and generate the data. Then you will be able to import it.

Options for inserting images/data from LumaSpec Offline Analyzer are:

Template Choose from two quick templates: ROI Template (portrait) and Line Profile
and ROI Template (portrait)

Thermal Image Choose to insert a Thermal Image Frame (thermal, visual, and sound file), or
simply a Thermal Image (Thermal Image only).

Isotherm Choose to insert an Isotherm Frame (Isotherm, sound file, and data), Isotherm
Image (Image only), or only the Isotherm Data (data only).

ROIs Choose to insert an ROI Frame, ROI Image, or simply ROI data.

Line Profile Choose to insert a Line Profile Frame, Line Profile Image, Line Profile Graph,
or simply Line Profile Data.

3D Profile Choose to insert a 3D Profile Frame or simply the 3D Profile Image.

Histogram Insert a histogram, with temperature data, minimum, and maximum.

Sound File Insert an embedded sound file at the cursor’s point.

Visible Image Inserts a visible image

Company
Information

Inserts the company information that was specified in the Tools > Options >
Company Information tab.



LumaSpecTM Offline Analyzer User Manual Using the Report Writer  102

Image Information Choose to insert Date, Time, Min. Temperature, Max. Temperature,
Comment, Memo, Equipment ID, Equipment Location, and User Fields
(Choose 1-10). All these will come from pre-entered information in LumaSpec
Offline Analyzer. If the specific information chosen has not been pre-
defined in LumaSpec Offline Analyzer, Report Writer will alert you
(as shown in the example with the Line Profile). Once entered in
LumaSpec Offline Analyzer, the data can be inserted in the Report
Writer.

Template Fields

Use this menu to add text labels to an image.

Infrared Image (F2) Insert a field for an infrared image

Visible Light Image
(F3)

Insert a field for a visible light image

Sound File (Shift + F2) Insert a field for a sound file

Image Information Insert a field for Name, Title, Date (Ctrl + F2), Time (Shift + Ctrl + F2),
Emissivity, Background, Memo, Comment, Min. Temperature, Max.
Temperature, and Temperature Unit

Equipment ID Insert a field for equipment ID information

Equipment Location Insert a field for Equipment location information

User Fields Insert user fields, 1-10

Company
Information

Insert fields for Company Name, Address 1, Address 2, City, State, Zip Code,
and Phone Number

System Date (Ctrl + D) Insert a field for System Date

System Time (Ctrl + E) Insert a field for System Time

Report Title Insert a field for a Report Title

Report Summary
Table

Insert a field for an Image
Summary, Equipment ID
Summary, Equipment ID
and Image Summary, or
User Field Summary. When
User Field Summary is
chosen, this window
appears, allowing you to
design the table:

3D Profile (F4) Insert a field for a 3D Profile
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Histogram (F5) Insert a field for a Histogram

Isotherm Image (F6) Insert a field for an Isotherm Image

Isotherm Data (Shift
+ F6)

Insert a field for Isotherm Data

ROI Image (F7) Insert a field for an ROI Image

ROI Line Profile (Shift
+ F7)

Insert a field for an ROI Line Profile

ROI Data Table (F8) Insert a field for an ROI Data Table

ROI Fields Insert a field for an ROI Reference Temperature, an ROI Reference Emissivity
field, or a customer ROI Data Field. If you choose ROI Data Field, this window
appears:

Choose an ROI Channel and Field to specify the kind of information your
template field will hold.

Page Number (Shift +
F1)

Insert a page number field

Test Template (F1) This choice allows you to test your custom template. A Template Preview
window appears (similar to a Print Preview window), and you can zoom, or
close the Template Preview and resume editing.

Note: LumaSpec Offline Analyzer contains embedded sample data, which appears in the
appropriate fields to help you test your custom template.

Text - Insert text files (.txt or .rtf) into LumaSpec Offline Analyzer Report Writer.

Image - Choose to insert an image (.bmp, .gif, tif, .jpg, and .wmf files) at cursor position, or as a
fixed object within the Report. Inserting at the cursor position integrates the image into the flow of
the text, which enables the software to automatically move the image with the text if you insert or
delete lines. Inserting as a fixed object places the object separate from the text, and the text flows
around it. Refer to Format > Image for information on how to format an imported image.

Object - Choose to insert a wide variety of OLE-2 compliant documents directly into the active
Report Writer document. You may insert at cursor position, or as a fixed object within the Report.
You may embed many types of objects, like spreadsheets, Adobe Acrobat .pdf files, or sound files.
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You may insert an existing document, or a new document. If you inset a new document, the Report
Writer adds a new document window to the active report document and launches a version of the
software type that you specified in the Insert Object Window.

Note: Use Insert > Object when you would like an embedded object to launch another
application inside LumaSpec Offline Analyzer Report Writer. For example, if you insert an
Adobe Acrobat .pdf as an object, an Acrobat .pdf icon is inserted. Adobe Acrobat is
launched within Report Writer, so you may view the .pdf file. This way you avoid time-
consuming conversion procedures. Remember to consider the software your final report
audience has available to them.

Edit - This command is accessible by using your mouse to right-click the object or text you would
like to edit. Right-clicking reveals the choices of Cut, Copy, Paste and Delete.

Page Break - Force content to the next page by inserting a Page Break.

6.3.5 Format

The Format pull-down menu provides access to the various Report Writer format commands. Each
format submenu has its own window, providing various options for formatting.

Character

Opens a window showing font choices and formatting options:

Text Color

A window appears showing color choices for text.
You may enter your own RGB mix, or use the
mouse to select a color. When you have selected
the color you desire, click Add to Custom Colors
for easier reference next time.

Background Color

The same color menu appears but for background
text color. This color appears to “highlight”the
text, appearing in bars behind it.
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Paragraph

Opens a Paragraph Format window, with Line Spacing and Alignment options, Indent settings and
settable Distances. See below:

Bullets and Numbering

This submenu controls various outline formats like numbering and lettering, Roman numerals, and
bullets. A window appears with options for these various formats:

Paragraph Frames

Opens a Paragraph Frames options window. You may define the size, type, and location of frames
around the current paragraph. Choose the orientation of Frame Parts, and choose Frame Styles.
Enter Line Width and Text Distance.
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Image

This option opens an Image Attributes window, which allows you to check various Image Options,
as well as manually scale the image.

The Fast Display option allows the software to display the current page without using extra memory
to display the image. With Fast Display checked, the software displays the image as a gray box. The
Save As Data option embeds image data in the report. If you do not select Save As Data, the
software links to the location of original image file outside of the report document.

LumaSpec Offline Analyzer Template

The Template Setup/Formatting submenu allows formatting of the standard ROI Template and
ROI/Line Profile Templates. A new screen opens, as shown below, allowing field changes. You must
click the Save Changes button to save any changes made in the Template Setup screen. (Clicking the
Close button before saving will cause you to lose your changes.)
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6.3.6 Table

Insert

Table This submenu allows you to insert a table at the cursor position in the
document. When you select Table > Insert > Table, the Table Attributes
window appears, and prompts you to specify the number of rows and
columns for the table. Either select values from the pull-down menus
provided or manually input values into the Rows and Columns fields. You
may format the table using Table > Properties.

Column to the Left Inserts a column to the left of the cursor location in the current table.

Column to the Right Inserts a column to the right of the cursor location in the current table.

Row Above Inserts a row above the cursor location in the current table.

Row Below Inserts a row below the cursor location in the current table.

Delete

Table (Ctrl + T) Deletes selected table.

Column (Ctrl + M) Deletes selected column(s), or column where cursor is located.

Row (Ctrl + R) Deletes selected row(s), or row where cursor is located.

Select

Table Selects entire table in which cursor is located.

Row Selects row in which cursor is located.

Cell Selects cell in which cursor is located.

Grid Lines

Check this item on the Table menu to see Table Row/Column borders (grid lines). These light gray
lines do not print, however. Uncheck this item to hide the grid lines.

Column Width

The Column Width window appears, in which you can set the column width of the cells of the
current table. The Table Column Width window also enables you to set the horizontal position of
the current table. The horizontal position can be Left, Right, Centered or User Defined. To adjust
the column widths in a table, click in any cell of an existing table, then select the Table > Column
Width menu item.
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Properties

Opens the Table Frame window (below) in which you can set the various attributes that create and
control the frames around the cells of the current table. The Table Frame window also lets you
assign fill colors to the table, and control the text position within the cells.

6.3.7 Window
The Window pull-down menu enables you to arrange your open report document windows.
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Cascade Staggers windows so you can see the upper left corner and name of each.

Tile Horizontal Divides the screen horizontally, giving each window equal area.

Tile Vertical Divides the screen vertically, giving each window equal area.

Arrange Icons Organizes all minimized files in the lower left corner of the Report Writer.

6.4 Report Wizard
The Report Writer Wizard reads the data from the LumaSpec Offline Analyzer Report Queue (see
Chapter 5 of this manual.) The Report Writer Wizard dialog box (shown below) allows you to create
a new Report or append to an existing report. This dialog box automatically appears when you
launch Report Writer from LumaSpec Offline Analyzer and have added information to the Report
Queue.

Enter the Report Title. Select the Cover Page, Data Page, and Summary Page templates to use and
click OK. The Report Writer will apply all of the data from the LumaSpec Offline Analyzer Queue to
the template selected. If the user defined template is one page and three infrared images are sent
to the Queue, then the Wizard will generate a three-page report. If the user defined template is
two pages and three infrared images are sent to the Queue, the wizard will generate a six-page
report.

When using all three templates (Cover, Data, and Summary) a complete report will be generated.
To reduce the file size of the report, check the Compress Visible Light Images checkbox. The
Report Writer will shrink the visible light images to 320 x 240 pixels.

If the user defined data template uses company
information fields (see Section 6.3.4 for
description of template fields,) then click on the
Company Info button. The Company Info
window appears (shown right.) Fill in the desired
information.
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A report generated using the Electric 1 template in the report wizard would look like this:
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7 Using Report Writer Templates

The section provides more information on how to create custom report layouts using the Report
Writer Template Creator/Editor. The Report Writer allows you to create custom templates and edit
pre-made templates.

7.1 Loading Templates
To load a user template:

1. Launch the Report Writer from LumaSpec Offline Analyzer or from the Windows Start
Menu.

2. In the Report Writer menu, click on File > Open.

3. An Open File dialog box will appear.

4. Select the LumaSpec Offline Analyzer\Templates folder on your hard drive.

5. Select the Cover, Data, or Summary folder.

6. In the Files of Type list at the bottom of the Open File window, select LumaSpec Offline
Analyzer Report Template (*.mrt)

7. Select the Template to load and click on the Open button (See window below).

8. The selected template will now be loaded into the Report Writer for editing.

7.2 Inserting Template Fields
7.2.1 Normal Template Fields
To insert template fields:

1. Place the cursor in the document where the fields
will be inserted.

2. Right-click at the cursor’s point to bring up the
Insert Menu.

3. Select Template Fields from the Insert Menu.

4. Select the field to be inserted.

5. A Field tag will be inserted into the document. In
this case, «VIS» is displayed when “Visible Light
Image” is selected.

All Template Fields begin with « and end with ».

6. The fields can be placed anywhere in the template document, including templates.

You can format the tag to have any text color, font, or type size. For example, if you insert
the System Date Field and then format the tag to be blue, Arial, Bold, 12 pt. size, the tag
looks like this: «SYSD». When the template is executed, the tag would be replaced with
the System Date and would look like: 3/29/07. Any attribute you assign to the tag will be
applied to the data that replaces the tag when the template is executed.
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7.2.2 Special Template Fields
There are two special types of fields that can be inserted into templates.

ROI Data Tables

The first kind of special template field is the ROI Data Table. This field is a complete ROI table that
will automatically adjust the number of columns to the number of ROIs defined in the Report
Queue information. If there is no Distance to Target information defined, then the ROI Data Table
will also remove the Distance and Area Rows. The figure below shows a sample of the ROI Data
table fields. The second figure shows the results of the ROI Data table with the 5 ROIs defined.

Individual ROI Fields

The second special type of fields that can be inserted are the individual ROI fields. The Reference
Temperature and Emissivity, or any ROI value, can be inserted into the template.

To insert ROI fields:

1. Place the cursor in the document where the fields will be inserted and right-click to bring up
the Insert menu.

2. Select Template Fields from the Insert menu.

3. Select ROI Fields from the Template Fields menu.

4. Select the fields to insert.
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If you choose ROI Data, the figure below shows the Select ROI Fields dialog box appears.
Select the ROI Channel and Field, then click on OK.

7.3 Inserting Summary Template Tables
There are four special types of summary tables that can be inserted into a template. Image
Summary, Equipment ID Summary, Equipment ID and Image Summary, and User Field Summary.

7.3.1 Image Summary, Equipment ID Summary, and Equipment ID and
Image Summary

The first three summary tables have fixed fields. The User Field Summary table is user definable up
to 10 columns. Rows will be automatically added for each image record by the Report Wizard.

To insert a summary table:

1. Right mouse-click to bring up the Insert Menu.

2. Select Template Fields, and then Report Summary Table.

3. Select the Summary Table to be inserted.

Below are samples of the first three fixed summary tables:
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7.3.2 The User Field Summary Table
The User Field Summary Table is user configurable up to 10 columns.

Below is a sample of the User Field Summary configured to display results for inspecting 3-phase
equipment.

To insert a user field table:

1. Right-click to bring up the Insert Menu.

2. Select the Template Fields menu item.

3. Select Report Summary Table menu item.

4. Select the User Field Summary menu
item.

5. Select 7 Columns in the Select Number
of Columns drop down list. The dialog
box will display only this option (number
of columns) until you enter a number.

6. Type Image in the Column Header field.

7. Select Image File Title from the Column
Field drop down list.

8. Click on Column 2 in the Column field.

9. Type Unit in the Column Header field.

10. Select ROI Temperature Unit from the
Column Field drop down list.

11. Click on Centered in the Column
Alignment frame.

12. Click on Column 3 in the Column field.

13. Type Phase 1 in the Column Header field.

14. Select ROI Fields from the Column Field
drop down list. The ROI Fields window
opens, allowing you to choose which ROI
you want and which data will be
displayed for that ROI.

15. Select ROI 1 and Max Temperature from
the ROI Fields and Click Ok.

16. Click on Centered in the Column
Alignment frame.

17. Click on Column 4 in the Column field.

18. Type Phase 2 in the Column Header field.
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19. Select ROI Fields from the Column Field drop down list.

20. Select ROI 2 and Max Temperature from the ROI Fields and Click Ok.

21. Click on Centered in the Column Alignment frame.

22. Click on Column 5 in the Column field.

23. Type Phase 3 in the Column Header field.

24. Select ROI Fields from the Column Field drop down list.

25. Select ROI 3 and Max Temperature from the ROI Fields and Click Ok.

26. Click on Centered in the Column Alignment frame.

27. Click on Column 6 in the Column field.

28. Type Ambient in the Column Header field.

29. Select ROI Fields from the Column Field drop down list.

30. Select ROI 4 and Max Temperature from the ROI Fields and Click Ok.

31. Click on Centered in the Column Alignment frame.

32. Click on Column 7 in the Column field.

33. Type Page in the Column Header field.

34. Select Image Page Number from the Column Field drop down list.

35. Click on Centered in the Column Alignment frame.

36. Click on Insert to insert the User Field Summary Table.

37. Use Table Properties and Table Column Width to adjust the inserted table.

The resulting template should look like this:

7.4 Testing a Template
The LumaSpec Offline Analyzer Report Writer has built-in sample data to test your user-defined
template without exiting Report Writer. To test a template, simply press F1 on your keyboard. Your
Template will now be populated with the Report wrier’s test data and a Template Preview Window
will be displayed. This window is read-only and is intended to give you a visual preview of your
template. To return to your template, click on the Close button in the upper left corner of the
screen.

7.5 Saving a Template
To save a template:

1. Click on File > Save in the Report Writer text menus. A Save Template As dialog box will
appear.

2. In the filename field, type the name that you wish to call this template (i.e. “My Template”).
Report Writer will automatically append the MRT extension to the filename. Before saving,
verify that the folder in the Save In field is Templates\Cover, Templates\Data, or
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Templates\Summary. The Report Wizard will only look in the Templates folder for user-
defined templates.

3. After you have entered the filename for the template, click on Save. The user-defined
template will now be saved. See the example of the Save Template As dialog box below:
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